
 

 

VmDas 
User's Guide 

 

 
 

 

P/N 95A-6015-00 (March 2001) 

 

RD Instruments 
Acoustic Doppler Solutions 



 

 

 



 

 

Table of Contents 
1 Introduction....................................................................................................................................... 1 

1.1 System Requirements.........................................................................................................................1 
1.1.1 Using Windows 95 ..............................................................................................................................2 
1.1.2 Using Windows NT .............................................................................................................................2 

1.2 Software Installation............................................................................................................................2 
2 Turnkey Mode ................................................................................................................................... 3 
3 Quick Start Guide ............................................................................................................................. 4 

3.1 ADCP Setup........................................................................................................................................4 
3.2 Test the ADCP....................................................................................................................................5 
3.3 Start VmDas........................................................................................................................................6 
3.4 Setup Communications.......................................................................................................................7 
3.5 Load a Command File.........................................................................................................................8 
3.6 Set Recording Options......................................................................................................................10 
3.7 Setup the Transforms Screen ...........................................................................................................11 
3.8 Save the User Option File.................................................................................................................12 
3.9 Collect Data ......................................................................................................................................13 

4 VmDas Tutorial ............................................................................................................................... 14 
4-1 Creating a Data Option File...............................................................................................................14 

4.1.1 Setting up Data Options....................................................................................................................15 
Saving Data Options .........................................................................................................................15 
Error Messages.................................................................................................................................16 
Loading Data Options .......................................................................................................................16 
View the Current Data Options .........................................................................................................16 

4.1.2 Setting up Display Options................................................................................................................16 
Edit Display Options..........................................................................................................................17 
Reference Tab ..................................................................................................................................17 
Ship Track Tab..................................................................................................................................19 
Change Chart Properties ..................................................................................................................21 

4.2 Data Options Screens.......................................................................................................................23 
4.2.1 Editing the Data Options ...................................................................................................................23 
4-2.2 Communication Tab..........................................................................................................................24 
4.2.3 ADCP Setup Tab ..............................................................................................................................27 
4.2.4 Recording Tab ..................................................................................................................................29 
4.2.5 Transforms Tab.................................................................................................................................31 
4.2.6 Averaging Tab...................................................................................................................................33 
4.2.7 Data Screening Tab ..........................................................................................................................35 
4.2.8 Users Exits Tab.................................................................................................................................37 
4.2.9 Simulated Inputs Tab ........................................................................................................................39 

4.3 Command Files.................................................................................................................................40 
4.3.1 VmDas ADCP Initialization................................................................................................................42 
4.3.2 Choosing Setup Parameters .............................................................................................................42 
4.3.3 Using the ADCP Setup Options ........................................................................................................42 
4.3.4 Using a ADCP File Option.................................................................................................................42 
4.3.5 Interactions .......................................................................................................................................43 
4.3.6 Automatically Generated Commands ...............................................................................................43 

Manual pinging..................................................................................................................................43 
Beam coordinates .............................................................................................................................43 
Magnetic corrections.........................................................................................................................43 

4.3.7 Commands and How They are Generated........................................................................................44 
Set Profile Parameters......................................................................................................................44 
Set Processing Mode........................................................................................................................44 
Set BT On/Off ...................................................................................................................................45 
Heading/Tilt Sensor ..........................................................................................................................45 

4.3.8 Serial Port Setup...............................................................................................................................45 
4.3.9 Detailed ADCP Initialization Procedure.............................................................................................46 

4.4 Reprocessing Data with VmDas .......................................................................................................49 
4.5 Playback a Data File .........................................................................................................................50 



 

 

5 VmDas and NMEA Data.................................................................................................................. 51 
5.1 General NMEA Data Format .............................................................................................................51 
5.2 NMEA Input.......................................................................................................................................53 

5.2.1 GGA – Global Positioning System Fix Data......................................................................................53 
5.2.2 HDG – Heading, Deviation, and Variation.........................................................................................54 
5.2.3 HDT – Heading – True......................................................................................................................54 
5.2.4 VTG – Track Made Good and Ground Speed...................................................................................55 
5.2.5 $PRDID.............................................................................................................................................55 
5.2.6 Reading NMEA Data.........................................................................................................................55 

5.3 NMEA Output....................................................................................................................................56 
5.3.1 $VDDBT – Depth Below Transducer ................................................................................................56 
5.3.2 $VDHDT – Heading – True...............................................................................................................56 
5.3.3 $VDVBW – Dual Ground/Water Speed.............................................................................................57 
5.3.4 $VDZDA – Time and Date ................................................................................................................57 
5.3.5 Writing NMEA Data...........................................................................................................................57 

5.4 Internal NMEA Messages .................................................................................................................58 
5.4.1 $PADCP............................................................................................................................................58 

5.5 Further Information About NMEA Strings..........................................................................................58 
6 VmDas Outputs............................................................................................................................... 59 

6.1 Output Ensemble Data......................................................................................................................59 
6.2 Output Speed Log Data ....................................................................................................................59 
6.3 Output ASCII Ensemble Data ...........................................................................................................61 

6.3.1 ASCII Ensemble Output Format........................................................................................................62 
6.3.2 Sample Ensemble-Out Data Transmission .......................................................................................62 
6.3.3 Ensemble-Out Data Format Description ...........................................................................................63 

7 VmDas User Exits ........................................................................................................................... 67 
7.1 Tips and Tricks to Creating User Exit Programs ...............................................................................68 
7.2 Example 1 - Modifying Raw ADCP Data...........................................................................................69 
7.3 Example 2 - Modifying Raw NMEA Data ..........................................................................................69 
7.4 Example 3 - Transformation..............................................................................................................70 
7.5 User Displays....................................................................................................................................71 

8 File Naming Conventions............................................................................................................... 73 
9 ADCP Output Data Format and VMDAS ....................................................................................... 74 

9.1 Binary Navigation Data Format .........................................................................................................75 
9.2 Navigation Data Format – Detailed Explanation ...............................................................................78 

 



 

 

List of Figures 
Figure 1. Autostart Dialog............................................................................................................... 3 
Figure 2. Reference Tab............................................................................................................... 17 
Figure 3. Ship Track Tab .............................................................................................................. 19 
Figure 4. Chart Control Properties ............................................................................................... 21 
Figure 5. Ship Track Properties Dialog......................................................................................... 22 
Figure 6. Communications Tab..................................................................................................... 24 
Figure 7. ADCP Setup Tab ........................................................................................................... 27 
Figure 8. Recording Tab............................................................................................................... 29 
Figure 9. Choosing the Path......................................................................................................... 30 
Figure 10. Transforms Tab ............................................................................................................. 31 
Figure 11. Averaging Tab ............................................................................................................... 33 
Figure 12. Data Screening Tab....................................................................................................... 35 
Figure 13. Users Exits Tab ............................................................................................................. 37 
Figure 14. Simulated Inputs Tab..................................................................................................... 39 
Figure 15. Playing Back a Data File ............................................................................................... 50 
Figure 16. User Exits...................................................................................................................... 72 
Figure 17. ENS, ENX, STA and LTA Binary Output Data Format ................................................... 74 
Figure 18. Binary Navigation Data Format ..................................................................................... 75 
 

List of Tables 
Table  1: Ensemble Time ............................................................................................................... 8 
Table  2: Example User Option Files.............................................................................................. 8 
Table  3: NMEA Data Format ....................................................................................................... 51 
Table  4: Data Fields .................................................................................................................... 52 
Table  5: GGA NMEA Format....................................................................................................... 53 
Table  6: HDG NMEA Format....................................................................................................... 54 
Table  7: HDT NMEA Format ....................................................................................................... 54 
Table  8: VTG NMEA Format ....................................................................................................... 55 
Table  9: PRDID NMEA Format ................................................................................................... 55 
Table  10: VDDBT NMEA Format .................................................................................................. 56 
Table  11: VDHDT NMEA Format .................................................................................................. 56 
Table  12: VDVBW NMEA Format ................................................................................................. 57 
Table  13: VDZDA NMEA Format .................................................................................................. 57 
Table  14: PADCP NMEA Format................................................................................................... 58 
Table  15: Ensemble-Out Data Format .......................................................................................... 63 
Table  16: Binary Navigation Data Format ..................................................................................... 78 
 



 

 

NOTES 
 

 

 



 VmDas User's Guide 

P/N 95A-6015-00 (March 2001) page 1 

 

 

VmDas User's Guide 
 

1 Introduction 
VmDas is a software package for use with RDI Vessel Mount Acoustic Doppler 
Current Profilers.  This software package supports the Broadband, Workhorse, 
and Ocean Surveyor PD0 Binary Output Data Formats for data collection and 
replay. 

 
NOTE.  This guide covers version 1.2.0.7 or higher. 

1.1 System Requirements 
VmDas requires the following: 

• Windows 95® (see “Using Windows 95,” page 2), Windows 98®, or 
Windows NT 4.0® with Service Pack 4 installed (see “Using Win-
dows NT,” page 2) 

• Pentium class PC 233 MHz (350 MHz or higher recommended) 

• 32 megabytes of RAM (64 MB RAM recommended) 

• 6 MB Free Disk Space plus space for data files (A large, fast hard 
disk is recommended) 

• One Serial Port (two or more High Speed UART Serial Port recom-
mended) 

• Minimum display resolution of 800 x 600, 256 color (1024 x 768 
recommended) 

Acoustic Doppler Solutions
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• CD-ROM Drive 

• Mouse or other pointing device 

• An Ethernet card if network I/O is desired 

 
NOTE.  VmDas can use up to six serial ports in some configurations. 

1.1.1 Using Windows 95 
To use VmDas with Windows 95 you must have the ws2_32.dll file installed on 
your computer.  To determine if you have this file, click Start, Find, Files or 
Folders.  In the Named box, type ws2_32.dll and click Find Now.  If the file 
is included on your system, then proceed with the VmDas software installation.  
If the file is not on your computer, do the following. 

a. Go to http://www.Microsoft.com/windows95/downloads/  

b. It is highly recommended that you download and install all of the critical 
and recommended updates, and the service releases for Windows 95. 

c. Scroll down the list of files on the Windows95 download page and select 
the Windows Socket 2 Update link.  Click the Download Now button.  
This will download the w95ws2setup.exe file.  Double-click the file to in-
stall it.   

d. You will also need to download and install the Microsoft DUN 1.3 and 
Winsock2 Year 2000 Update.  Use the link on the Windows Socket 2 Up-
date page to get the y2kvdhcp.exe file.  Double-click the file to install it 
(install the w95ws2setup.exe file first if you have not already done so). 

1.1.2 Using Windows NT 
You must have Windows NT 4.0® Service Release 4 or higher installed before 
attempting to install VmDas.  VmDas cannot install on the computers running 
Windows NT 3.0 or earlier versions.   

1.2 Software Installation 
To install VmDas, do the following. 

a. Insert the compact disc into your CD-ROM drive and then follow the 
browser instructions on your screen.  If the browser does not appear, com-
plete Steps “b” through “d.” 

b. Click the Start button, and then click Run. 

c. Type <drive>:launch.  For example, if your CD-ROM drive is drive D, 
type d:launch. 

d. Follow the browser instructions on your screen. 

http://www.microsoft.com/windows95/downloads/
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2 Turnkey Mode 
When VmDas is started in the turnkey mode, a message box appears to prompt 
the user to start collecting data.  After 30 seconds, or on confirmation, VmDas 
begins collecting data automatically.   

Syntax – VmDas.exe /autostart 

For example, if a computer operating system has VmDas with the /autostart 
switch in the startup folder, VmDas will open with a message box asking if it is 
OK to start collecting data when the computer is started.  The user clicks OK 
or waits 30 seconds for the message box to time out.  VmDas will close the 
message box, open a document in data collect mode, and begin collecting data.  
If the user clicks Cancel, VmDas exits. 

 
Figure 1. Autostart Dialog 
 

 

NOTE.  Turnkey mode only works on startup.  Once data collection has 
started, VmDas reverts to normal operation.  It will not enter turnkey mode 
again until closed and restarted with the /autostart switch.  If a second 
document is opened with the File, Collect Data menu, the user must use 
the Control, Go menu item to start data collection.  It will not happen 
automatically. 
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3 Quick Start Guide 
The VmDas User’s Guide is divided into two main sections: 

1. Quick Start Guide to collecting data with VmDas 

• Simple instructions to begin collecting data 
2. VmDas Tutorial 

• Create a User Option file 

• Collecting data 

• How to reprocess data 

• How to play back a data file 
Making accurate profile measurements is less difficult than you probably be-
lieve now.  You will soon see that you need to use only a few keystrokes on the 
computer to collect data in the field.   

Please take the time to read this entire manual.  It will be useful to have the 
ADCP and a computer available to follow along.  You may also want to keep 
the ADCP Technical manuals handy for reference when you want more detail. 

3.1 ADCP Setup 
Step 1.  Connect the ADCP and computer as shown in your ADCP Technical 
Manual.  If you have not already installed VmDas and the RDI Tools CD, do so 
as outlined in “Software Installation,” page 2.   

Use this area for notes. 
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3.2 Test the ADCP 

 
Step 2.  Run DumbTerm to verify the ADCP is functioning properly.  Select a 
script file from the table below.  The results of the tests will be saved to an 
ASCII text log file in the same directory as the DumbTerm is running from.   

Script File Name ADCP Type Results Saved to 

testBB.txt Broadband BB_RSLTS.txt 

testOS.txt Ocean Surveyor OS_RSLTS.txt 

testWH.txt Workhorse  WH_RSLTS.txt 
 

These text files (*.txt) were copied into the same directory as DumbTerm when 
you installed the RDI Tools software CD sent with your system.   

Use this area for notes. 
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3.3 Start VmDas 

 
Step 3.  Start VmDas.  On the File menu, click Collect Data.   

On the Options menu, click Load.  Select the Default.ini file and click Open.  
This will set VmDas to the factory default options. 

Use this area for notes. 
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3.4 Setup Communications 

 
Step 4.  On the Options menu, click Edit Data Options.  Click the Communi-
cations tab and set the communications settings with the ADCP and NMEA 
ports.   

Use this area for notes. 
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3.5 Load a Command File 

 
Step 5.  Click the ADCP Setup tab.  Use the ADCP Setup tab to setup the 
ADCP.  Set the Ensemble Time to the value shown in Table 1.   

Table  1: Ensemble Time 
Frequency (kHz) With Bottom Track (sec) Without Bottom Track (sec) 

38 4 2 

75 2 1 

150 1 1 

300 

600 

1200 

Select Ping as Fast as possible 

 

For this Quick Start example, select Use File in the ADCP Setup file area.  
Use Table 2 to choose a command file for your ADCP, and load it into VmDas 
using the Browse button.  These text files (*.txt) were copied into the same di-
rectory as VmDas when you installed it from the CD sent with your system.   

Table  2: Example User Option Files 
File Name Description 

OS38BBDEF Default setup for an OS 38kHz ADCP in the highest precision (broad bandwidth) but 
reduced range profiling mode. 
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File Name Description 

OS38NBDEF Default setup for an OS 38kHz ADCP in the lowest precision (narrow bandwidth) but 
extended range profiling mode. 

OS75BBDEF Default setup for an OS 75kHz ADCP in the highest precision (broad bandwidth) but 
reduced range profiling mode. 

OS75NBDEF Default setup for an OS 75kHz ADCP in the lowest precision (narrow bandwidth) but 
extended range profiling mode. 

OS150BBDEF Default setup for an OS 150kHz ADCP in the highest precision (broad bandwidth) but 
reduced range profiling mode. 

OS150NBDEF Default setup for an OS 150kHz ADCP in the lowest precision (narrow bandwidth) but 
extended range profiling mode. 

BB75DEF Default setup for a BB 75kHz ADCP to provide the most range with the optimal precision. 

BB150DEF Default setup for a BB 150kHz ADCP to provide the most range with the optimal precision. 

BB300DEF Default setup for a BB 300kHz ADCP to provide the most range with the optimal precision. 

BB600DEF Default setup for a BB 600kHz ADCP to provide the most range with the optimal precision. 

WH300DEF Default setup for a Workhorse 300kHz ADCP to provide the most range with the optimal 
precision. 

WH600DEF Default setup for a Workhorse 600kHz ADCP to provide the most range with the optimal 
precision. 

WH1200DEF Default setup for a Workhorse 1200kHz ADCP to provide the most range with the optimal 
precision. 

 

 
NOTE.  These text files (*.txt) were copied into the same directory as 
VmDas when you installed it from the software CD sent with your system.   

 

 

NOTE.  These files have been setup for shipboard use.  They can also be used 
for stationary systems (such as Oil Rig platforms) but you must first open the 
file (right click on file and select open) and modify the EZ command from 
EZ1020001 to EZ1111111.  This new setting will enable the use of the internal 
heading, pitch, and roll sensors. 

 

Use this area for notes. 
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3.6 Set Recording Options 

 
Step 6.  The Recording property page allows you to set the deployment name 
and path to where the data files are recorded.   

Enter a name in the Name box that identifies your deployment.  This name will 
be used as part of the filename for each file that is part of this deployment (see 
“File Naming Conventions,” page 73).  For testing, “Test” or “Practice” are 
good choices.  

In the Primary Path box, enter the drive and directory where you would like 
to store the files of collected data.  Use the Browse button or enter the path 
manually.  

Use this area for notes. 
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3.7 Setup the Transforms Screen 

 
Step 7.  Click the Transforms tab and verify that all selections in the Trans-
form Type are checked.  Set the Sensor Configuration, Orientation, and 
Beam Angle to Instrument Default.  The Heading Source and Tilt Source 
should be set to ADCP.  Set the Heading Correction to your input.  The Ve-
locity Scaling should be disabled. 

Click OK to save the changes made to the Program Options tabs.   

 

NOTE.  If you have the vessel’s gyro connected to the electronic chassis or 
your ADCP has an internal compass, then select ADCP.  If you have 
heading data coming into the serial port on the computer, select 
NMEA/HDT or NMEA/HDG depending on your device output. 

 

Use this area for notes. 
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3.8 Save the User Option File 

 
Step 8.  On the Options menu, click Save As.  The options may be saved to a 
file for later retrieval.  You may wish to save several sets of options, to be used 
as starting points for different deployments.  Option files that are created this 
way may have any name you choose. 

 

NOTE. The *.ini file includes the path to the command (*.txt) file you 
choose.  This allows you to create a *.ini file for each command file or have 
different *.ini files with different processing parameters (averaging screens, 
etc.) pointing to the same command file. 

 

Use this area for notes. 
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3.9 Collect Data 

 
Step 9.  On the Control menu, click Go to begin collecting data.  The ADCP 
Communication window will open and show the commands from the command 
file you selected (see “Load a Command File,” page 8) being sent to the ADCP 
and the ADCP’s response.  Once all of the commands have been captured to 
the *.LOG file, the window will close automatically.  See “VmDas ADCP Ini-
tialization,” page 42 for details on how the ADCP commands are generated and 
sent to the ADCP. 

 
NOTE.  You can review the ADCP Communication window by selecting 
View, ADCP Communication. 

 

Use this area for notes. 
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4 VmDas Tutorial 
The first section of this User’s Guide presented a Quick Start to collecting data.  
The default Command files presented in that section will work for most condi-
tions.  There may be specific sites where you will need to create your own User 
Option files and Command files (see “Command Files,” page 40) if you want 
to change some of the sampling parameters.  The tutorial will go through a 
step-by-step procedure for creating a site-specific User Option file for collect-
ing data.  The tutorial will also go through the reprocessing data (see 
“Reprocessing Data with VmDas,” page 49) and data playback (see “Playback 
a Data File,” page 50).   

 

CAUTION.  If you edit the default command files with a text editor, be sure to 
back them up first, and save the file in plain text format when you have finished 
editing.  Extra formatting characters inserted for other document file formats will 
make the file unreadable by VmDas. 

 

4-1 Creating a Data Option File 
In the following, you will be creating a Data Option file that will be used to 
program both the ADCP and VmDas software processing.   

The VmDas, WinADCP, and RDI Tools software should be installed on your 
computer as outlined in “Software Installation,” page 2.  Connect the ADCP to 
a computer as shown in the ADCP Technical Manual, and apply power to the 
ADCP.   

a. Start VmDas.  Click File, Collect Data. 
b. Click Options, Load.  Select the Default.ini file.  Select Open. 

c. Click Options, Edit Data Options.  See “Data Options Screens,” page 23) 
for details on each tab.  Once you have set all the parameters, click OK to 
exit the Edit User Options screens.  When OK is clicked, VmDas checks 
the new options for consistency.  For example, it is not allowed to use the 
same serial port twice on the Communications tab.  If VmDas finds an er-
ror, it will display an error message box and refuse to close the Edit Data 
Options dialog box.  You may either correct the error(s), or use Cancel to 
abandon all changes to the options. 

d. Save the Data Option file by clicking Options, Save As.  Enter a file name 
for the *.ini file that you have just created.  This *.ini file will save the 
setup in all of the tabs including the path to the command text file.  You can 
use this same method in case you wish to create several different setup files 
for the same machine.  As an example, you could create a command text 
file that has a 6-meter bin size.  You might save this to a text file with the 
name BB150BIN6M.TXT and call the *.ini file 6METER.INI.  You could 
then create another command file and *.ini file with a 16-meter bin size 



 VmDas User's Guide 

P/N 95A-6015-00 (March 2001) page 15 

with the same concept.  Then when you want to actually use the proper 
command file you just have to select the *.ini file you intend to use.  

4.1.1 Setting up Data Options 
When data collection or data reprocessing is started, the current data options 
tell VmDas how to collect and process data. 

• Data options are not used for playing back data.  Editing them is not 
allowed in playback mode. 

• VmDas stores current data options.  They persist until changed, even 
if VmDas is closed and restarted. 

• If the current set of data options is not satisfactory, they must be 
changed before starting data collection or data reprocessing.  Once 
collection or reprocessing has started, it must be stopped before 
changes can be made. 

• Current settings can be viewed at any time when a mode is selected. 

• The current data options can be replaced with a set of data options 
stored in an *.INI, *.VMO, or *.VMP file.  The current options can 
be edited. 

Saving Data Options 
When the current data options are changed, the old version is overwritten.  To 
keep from losing a set of options, they should be stored in a file by clicking 
Options, Save As. 

• The Save As option is available only when options have been edited 
but not saved in a file. 

• Choose a file name that suggests the purpose of this set of data op-
tions.  VmDas will add the INI extension to the name.  No extension 
should be supplied by the user. 

• Whenever data collection starts, the current data options are auto-
matically saved in a VMO file. 

• Whenever reprocessing starts, the current data options are automati-
cally saved in a VMP file. 

• All of these files are stored as standard Windows INI files.  They are 
easy to read with a text editor.  Editing them directly is not recom-
mended. 
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Error Messages 
Some options or combinations of options are illegal.  VmDas detects some of 
these bad settings and refuses to allow them to be saved or used. 

• Clicking OK or Apply on the Edit Data Options dialog box causes 
VmDas to do a consistency check and save the new settings as the 
current data options if no errors are found. 

• The check is also done when starting data collection. 

• If an error is found, a message describing the error will pop up and 
no changes will be saved.  The user can either correct the problem, 
or cancel editing and lose all changes made. 

Loading Data Options 
On the Options menu, click Load.  By default, only INI files are displayed.  
VMO files can be displayed by choosing them in the Files of type box.  To 
display VMP files, choose all files in the Files of type box.  

 
NOTE.  To return to the factory default setting, select the Default.ini file. 

 

View the Current Data Options 
On the Options menu, click View Data Options.  The same dialog opens as 
when editing, but no changes can be made.  You can view the data options in 
the Playback mode. 

4.1.2 Setting up Display Options 
The Display Options determine how data is displayed.  

• They can be set for modes that display data (playback and collect).  

• They can be changed at any time when one of those two modes is 
active, whether or not data is being played or collected.  

• Graphs or charts may be erased and re-plotted because of changes to 
these options, but it makes no change to the data itself. 

• In reprocess mode, data is not displayed, so there are no settings to 
determine how it is displayed.  
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Edit Display Options 
Click Options, Edit Display Options to display a tabbed dialog box from 
which you can change the display options.  Click the Reference tab to select 
the display units, or the velocity reference to use for profiles.  Click the Ship 
Track tab to select the ship position source and the profile bins to use for the 
current stick plots. 

Reference Tab 
When you click the Reference tab (Figure 2) in the Display Options dialog 
box, the following display units and velocity reference settings are displayed 
and may be changed. 

 
Figure 2. Reference Tab 
Velocity Reference - Choose between None, Bottom Track, Water Mass Ref-
erence Layer, Water Current Profile Layer, Delta Position, Speed, and 
Speed/Dir Made Good. 

• Water Mass Reference Layer refers to the water reference layer 
output that some ADCP instruments output along with the bottom 
track data.  This layer is only available from the BroadBand and 
WorkHorse ADCPs.  This data is collected and recorded by these 
ADCPs only when the BK command is set to collect Water Mass 



VmDas User's Guide 

page 18 RD Instruments 

Layer and the BL command has been set to select the section of wa-
ter that will be measured to record a speed through the water.  This 
speed through the water is stored in a separate location in the bot-
tom track data.  Enabling this feature will reference all of the profile 
velocities to this recorded speed through the water.  This feature is 
typically enabled only when the bottom track is not possible and 
navigation data will not be collected. 

• The Water Current Profile Layer is setup as a totally independent 
water layer to reference the averaged data in either the STA or LTA 
files.  The user should set this to a number of consecutive bins that 
will represent only the vessel motion (i.e. that has as little real water 
motion as possible).  The Start and Stop bins selected will all be 
averaged together to produce a single speed through the water.  This 
speed through the water is stored in a separate location in computer 
RAM.  If not used it is discarded and not recorded.  Enabling this 
feature will reference all of the profile velocities to this recorded 
speed through the water.  This feature is only used when there is no 
bottom track or navigation data available.  

• Delta Position calculates a reference velocity as delta position di-
vided by delta time, where the position data is obtained from the 
NMEA GGA message.  The position used in the calculation is the 
last GGA position received in each ADCP data interval. 

• Speed calculates a reference velocity from speed and direction, ob-
tained from the NMEA VTG message, by resolving them into East 
and North components. 

• Speed/Dir Made Good calculates a reference velocity from speed-
made-good and direction-made-good, which is in turn calculated 
from the averages of position and time, as received in the NMEA 
GGA messages, for each ADCP data interval. 

Velocity Units - Choose between millimeters per second, meters per second, 
knots, or feet per second for all displayed velocity data. 

Depth Units - Choose between meters, centimeters, or feet for all displayed 
depth data. 
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Ship Track Tab 
When you click the Ship Track tab (Figure 3) in the Display Options dialog 
box, the following settings are displayed and may be changed. 

 
Figure 3. Ship Track Tab 
Ship Position Source - For each ship track plot, choose between NAV, Bottom 
Track, Water Mass Reference Layer, and Current Profile Layer. 

• If NAV is selected, the last NMEA GGA position received in each 
ADCP data interval is used to calculate the ship track, and can be 
displayed as a Lat/Lon position, or as a distance from the initial po-
sition.  The initial position is the first valid GGA position received 
that also is the last position received within an ADCP data interval. 

• If Bottom Track is selected, the ADCP bottom track velocity data 
are integrated to calculate a ship track. 

• If Water Mass Reference Layer is selected, the ADCP water refer-
ence layer data are integrated to calculate a ship track.  This layer is 
only available from the BroadBand and WorkHorse ADCPs.  This 
data is collected and recorded by these ADCPs only when the BK 
command is set to collect Water Mass Layer and the BL command 
has been set to select the water depths to collect a speed through the 



VmDas User's Guide 

page 20 RD Instruments 

water.  The delta speed and delta time between consecutive averag-
ing intervals is then used to calculate a distance traveled and direc-
tion and plotted on the Ship Track graph.  This feature is typically 
enabled only when the bottom track is not possible and navigation 
data will not be collected. 

• If Current Profile Layer is selected, the layer velocity is defined to 
be the average of the range of profile bins selected as the velocity 
reference, and that velocity is integrated to calculate a ship track.  
This layer is setup as a totally independent water layer to reference 
the averaged data in either the STA or LTA files.  The user should 
set this to a number of consecutive bins that will represent only the 
vessel motion (i.e. that has as little real water motion as possible).  
The Start and Stop bins selected will all be averaged together to 
produce a single speed through the water.   

The delta speed and delta time between consecutive averaging inter-
vals is then used to calculate a distance traveled and direction and 
plotted on the Ship Track graph.  This feature is typically enabled 
only when there is no bottom track or navigation data available.  

 

NOTE.  If Bottom Track, Water Mass Reference Layer, or Current 
Profile Layer is selected, the ship track is shown as a distance from the 
initial position, where the initial position is 0,0. 

 

Chart units for distances - Choose between Kilometers, Meters, Miles (statute), 
or Feet. 

Current Sticks - Choose to display up to three current sticks at each ship posi-
tion, and select which profile bin each stick represents. 

 

NOTE.  Changes made to the Ship Track tab may require that the ship 
track be re-plotted.  VmDas will issue a warning before accepting these 
changes.  If the ship track must be re-plotted, the ship track is erased.  
Plotting continues from the current position.   

When collecting data, this means it is a good idea to settle on desired 
configurations early.  Once erased from the display, the Ship Track cannot 
be redisplayed until the deployment files are played back. 

 



 VmDas User's Guide 

P/N 95A-6015-00 (March 2001) page 21 

Change Chart Properties 
Whenever you right-click on any profile plot, a pop-up property menu 
(Figure 4) is displayed from which you can change many attributes for the pro-
file graphs.   
Profile Plots 

• How do I manually set the ranges for the plot axes?  Select the Axes 
tab.  On the right, click the tab that contains the attribute that you 
want to change for the axis, in this case Scale.  On the left, click on 
the label of the axis you want to change.  On the right, enter new 
numbers for Max and Min and click OK or Apply. 

• How do I put symbol markers on my data points?  Select the Chart 
Styles tab.  On the right, click the Symbol Style tab.  On the left, 
click on the label for the series you want to mark (i.e. Style1, 
Style2, etc.).  Click the box labeled Shape and select a shape for the 
symbol.  Click the box labeled Size to set the size of the symbol.  
Click the Name box to set the desired color for the symbol.  Click 
OK or Apply.  Note that from the Chart Styles tab you can also set 
the line width, pattern, and color of each line in the graph. 

 
Figure 4. Chart Control Properties 
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Ship Track Plots 

• How do I manually set the ranges for the plot axes?  Right-click the 
ship track plot and click on Properties (Figure 5).  Click the Plot 
Area tab.  Manually enter values for Left, Right, Top, and Bottom.  
On this property page, you may also change the font, turn on or off 
the grid lines and set their style, and change the aspect ratio method.  
Click OK. 

 
Figure 5. Ship Track Properties Dialog 
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4.2 Data Options Screens 
Click Options, Edit Data Options to display a tabbed dialog box from which 
you can change the program options.   

• Communications (see “Communication Tab,” page 24) 

• ADCP Setup (see “ADCP Setup Tab,” page 27) 

• Recording (see “Recording Tab,” page 29) 

• Transforms (see “Transforms Tab,” page 31) 

• Averaging (see “Averaging Tab,” page 33) 

• Data Screening (see “Data Screening Tab,” page 35) 

• Users Exits (see “Users Exits Tab,” page 37) 

• Simulated Inputs (see “Simulated Inputs Tab,” page 39) 

4.2.1 Editing the Data Options 
On the Options menu, click Edit Data Options to display a tabbed dialog box.  
Data Options can be edited only when collect or reprocess mode is selected, 
and collection or reprocessing is not in progress. 

• Clicking OK or Apply causes VmDas to do a consistency check and 
save the new settings as the current data options. 

• If an error is found, a message describing the error will pop up and 
no changes will be saved.  The user can either correct the problem, 
or cancel editing and lose all changes made. 

• Editing data options saves them as the current options, not in a file 
(see “Saving Data Options,” page 15).   

 
NOTE.  If the save to a file step is skipped, the new current options still 
persist until changed, even if VmDas is closed. 
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4-2.2 Communication Tab 
When you click the Communications tab in the Program Options dialog box, 
the following communications settings are displayed and may be changed to 
match the communication parameters to those of the device you have con-
nected to the computer.  

 
Figure 6. Communications Tab 
VmDas can collect data from one to three input serial ports.  When collecting 
data, ensembles must be read from the ADCP input port.  The Navigation and 
RPH input ports can collect NMEA data if desired.  If both NMEA ports are 
used see “Reading NMEA Data,” page 55 for details on which sentences are 
accepted at which port. 

Enabling an input port instructs VmDas to listen for data at that port, to log all 
data received to a file, and to generate error messages if data is not received.  
VmDas enforces some rules for input port options.  

• Duplicate or invalid COM ports cannot be specified for active ports.  
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• If options on the Transform page use NMEA data, at least one input 
port must be configured to accept it.  

• If only one NMEA port is enabled, it must be the Navigation port.  
VmDas can write data to up to three output serial ports and up to three TCP/IP 
ports.  

VmDas can provide up to three optional real time outputs through serial ports, 
Ethernet ports, or both.  

Enabling an output port instructs VmDas to write data to that port whether or 
not anyone is listening.  

Ensemble Output (Binary LTA) provides long term averaged ensembles. This 
output is a copy of the LTA output file. 

Ensemble output (ASCII) converts binary ensembles to an ASCII format. If 
this port is enabled, the data to be written must be selected in the Set Ensemble 
Output Configuration Here box.  

Speed Log Output produces NMEA messages containing ship speed informa-
tion from short term averaged data. 
Set Ensemble Output Configuration Here 

The settings in the Set Ensemble Output Configuration Here box are needed 
only if Ensemble Output (ASCII) is enabled. 

• Data Select - VmDas produces several output files with binary en-
sembles.  Data Select chooses one of these files as the source of en-
semble data for ASCII output.  Some of the data in the binary source 
will be extracted, converted to an ASCII format (See “Output ASCII 
Ensemble Data,” page 61), and written out the output port. 

• Data Type Switches - Select the type of data to send to the ensem-
ble-out device during data collection.  Check the appropriate check-
box for each type of data you want sent to the ASCII ensemble-out 
port.  The Navigation box will have no effect if the Data Select box 
contains ENR. Navigation data comes from NMEA inputs.  The 
navigation and ensemble data are merged to produce ENX, STA, 
and LTA files.  Navigation data is not present in the raw ENR files. 

• Velocity Switch - If the Velocity box is checked, the Start Bin and 
End Bin boxes in the Output column set the bins that will be added 
to the ASCII ensemble velocity data.  

• Velocity Ref - If the Velocity box is checked, the Velocity Ref box 
can be used to remove ship velocity from the velocity profile.  Other 
velocities, such as bottom track, are not changed.  

If Velocity Ref is set to None, velocities are unchanged.  
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If Velocity Ref is set to Bottom, the velocity from the bottom track 
field, if present, is subtracted from the velocity of each bin.  

If Velocity Ref is set to Mean, the average velocity of a water layer 
is subtracted from the velocity of each bin. The Start Bin and End 
Bin boxes in the Mean column select the bins that make up the wa-
ter layer. 

• Mean Start/End Bin - Lets you select the bin (depth cell) range for 
the Mean velocity reference. 

• Output Start/End Bin - Lets you select the portion of the ADCP 
profile (depth cell range) to send to the ASCII ensemble-out port. 

 

NOTE.  If the start and end bins are out of range (e.g., the ADCP 
ensemble contains 40 bins, and you set the Output Start Bin = 1 and the 
Output End Bin = 50), VmDas automatically adjusts the output bin range to 
the ADCP ensemble (i.e., Output End Bin = 40).   

 

 

Suggested Setting.   
The parameters set in the ADCP input port should match the ADCP 
wakeup serial port settings.  RDI recommends that the ADCP wakeup 
serial port settings be set at 9600 BAUD, no parity, 8 data bits, and 1 stop 
bit. 

The Navigation Input and RPH input ports read NMEA data.  The NMEA 
0183 standard specifies 4800 BAUD, no parity, 8 data bits, and 1 stop bit.  
Never the less, many ships use 9600 BAUD, and some may use faster 
rates. 

 

 

NOTE.  Advanced users can change the ADCP serial port parameters with 
a command file.  Those parameters are used only while collecting data. 
When data collection stops, the serial port settings the ADCP uses will 
return to their wakeup values.  

VmDas automatically changes the PC serial port when the ADCP serial 
port changes. 
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4.2.3 ADCP Setup Tab 
Use this dialog box to setup the ADCP.  Select either Use Options to set the 
ADCP commands on this tab or select Use File to use a command file.   

 
Figure 7. ADCP Setup Tab 
Ensemble Time is set on this tab for both Use Options and Use File.  Select 
the Set time between ensembles button to specify a ping interval (see Table 1, 
page 8).  Select the Ping as fast as possible button to let the processing and 
I/O time dictate the ping rate. 

 
NOTE.  See “VmDas ADCP Initialization,” page 42 for details on how the 
ADCP commands are generated and sent to the ADCP. 
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To set the ADCP commands using this dialog box, select the Use Options 
button. 

• Select the Set Profile Parameters box in the Water Current Pro-
file section to set the following parameters; Number of Bins (WN), 
Bin Size (WS), Blank Distance (WF), and Transducer Depth 
(ED).   

• Select the Set Processing Mode box to switch between high and low 
resolution modes.   

• Select the Set BT on/off box to enable or disable bottom track pings 
(BP1) and set the maximum search range (BX command).   

• Select the Heading Sensor Set Sensor Type box in this section to 
switch between using the ADCP's internal sensor or an external ana-
log gyro (synchro/stepper) (EZ command).   

• Select the Tilt Sensor Set Sensor Type box in this section to switch 
between using the ADCP's internal sensor or an external analog 
gyro (synchro) (EZ command).  When this box is not checked, the 
default ADCP setup will be used. 

To set the ADCP commands using a command file, select the Use File button.  
Enter the name of an ADCP command file in the Command File box, or click 
the Browse button to navigate to a file using a File Open dialog box.  This 
should be a text file with one ADCP command per line, and can have any valid 
ADCP commands.  The contents of this file will be sent to the ADCP during 
initialization. 
 

 

Suggested Setting for First Time Users.   
Select the Use File button in the ADCP Setup file area and click the 
Browse button under the Command File window.  Select one of the 
default command files (see “Load a Command File,” page 8 and 
“Command Files,” page 40) and click Open.   

Set the Ensemble Time as shown in Table 1, page 8. 
 

 
NOTE. The ADCP automatically increases the Time per Ensemble if 
((WP + NP + BP) x TP > the setting in Set time between ensembles box).   
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4.2.4 Recording Tab 
The Recording property page allows you to set the deployment name and path 
to where the data files are recorded. 

 
Figure 8. Recording Tab 
Enter a name that identifies your deployment.  This name will be used as part 
of the filename for each file that is part of this deployment (see “File Naming 
Conventions,” page 73). 

Normally, you do not need to enter a Starting Number as the software handles 
it automatically.  This deployment number is used to identify the specific data 
collection run, and becomes part of the filename of each data file recorded for 
the deployment.  If you do not enter a deployment number, the software will 
automatically assign one for each deployment. 

Enter the desired Maximum File Size.  Each file type in your deployment will 
be limited to the specified size.  Each file has a sequence number as part of the 
filename, and as each recorded file reaches the specified size limit, the se-
quence number will be incremented and a new file started. 
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Enter the Primary Path where the raw, intermediate, and processed data files 
are to be stored.  Clicking the Browse button to the right of the Primary Path 
edit box will allow you to browse your computer to select a folder to record to.  
You will be presented with a Choose Directory dialog box (see Figure 9), 
which will have the default path of C:\RDI\ADCP selected.  Select the primary 
path (note the directory must already exist) and click OK.   

 
Figure 9. Choosing the Path 
Check the Duel Output Directories box to create two copies of the raw data 
files and to allow a backup path to be entered.  If this box is not checked, only 
the Primary Path is enabled. 

Enter the Backup Path where optional backup copies of raw data and option 
files are stored.  These files are not used for data processing.  They are made 
available in case the primary files are lost.  If the backup copies are needed, 
copy them to the primary directory and reprocess them to create intermediate 
and processed data files. 

 

Suggested Setting.   
Enter a file name that identifies your deployment.  

Select the primary path (note the directory must exist already; VMDAS 
does not create it, except for the default path already entered). 
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4.2.5 Transforms Tab 
Use this screen to select the Transform Type, Sensor Configuration, Orien-
tation, Heading Source, Tilt Source, Beam Angle, Heading Correction, and 
Velocity Scaling.   

 
Figure 10. Transforms Tab 
Click the Transform Type checkboxes to enable or disable beam-to-Earth 
transformation, three-beam solutions, or bin mapping.  At present, VmDas av-
erages ADCP data in the Earth frame.  Therefore, if the Earth transformation is 
disabled, no averaged data will be produced.  Raw data will still be recorded. 

Select the appropriate Sensor Configuration radio button to indicate your sen-
sor configuration.  Select Instrument Default to have the software get the con-
figuration from the ADCP leader data. 

In the Orientation box, select Instrument Default to have the software get the 
orientation from the ADCP leader data.  Otherwise, by selecting the other radio 
buttons you may force a particular orientation for processing. 



VmDas User's Guide 

page 32 RD Instruments 

In the Heading Source box, select the ADCP radio button to have the software 
get heading data from the ADCP leader (internal compass or external syn-
chro/stepper analog gyro).  Otherwise, select the radio button for the NMEA 
message type that you wish to decode heading data from, or select the Fixed 
Heading radio button and enter a fixed heading value to use for the processing.  
Heading data from the selected source will be written into the ADCP variable 
leader in the ENX, STA, and LTA data files. 

In the Tilt Source box, select ADCP to have the software get tilt data from the 
ADCP leader data.  Select NMEA to have the software get tilt data from the 
$PRDID string on the NMEA port, or select Fixed Tilts to enter fixed values 
for pitch and roll to use for processing. 

In the Beam Angle box, select Instrument Default to have the software get 
the ADCP nominal transducer beam angle from the ADCP leader data.  Select 
Fixed to enter a fixed beam angle to use for processing. 

In the Heading Correction box, click the Enable checkbox if heading correc-
tion is desired.  Enter magnetic offsets such as magnetic variation in the EV 
edit box.  Enter transducer alignment offsets in the EA edit box.  Enter coeffi-
cients for the sin correction function in the K and phi edit boxes. 

Use the Velocity Scaling box if you need to correct velocity data that was col-
lected using the incorrect speed of sound, salinity, or temperature.   

For example, the user collects data using the factory default salinity for his 
ADCP.  Later, the user notices that this salinity value is wrong, causing an error 
in the velocities.  Calculate a scale factor (in this case, the same for profile and 
Bottom Track data), and open VmDas in the Reprocess mode (see 
“Reprocessing Data with VmDas,” page 49).  Enter the scale factor, and click 
OK to save the options.  Click Control, Go to reprocess the data.  
VmDas opens a reprocessing document with the selected data, opens the op-
tions dialog, validates and saves the new options, and reprocesses the data to 
new files, multiplying the velocities and error velocity thresholds in all new 
files by the scale factor. 

 

Suggested Setting.   
Enable all selections in the Transform Type.   

Set the Sensor Configuration, Orientation, and Beam Angle to 
Instrument Default.   
The Heading Source and Tilt Source should be set to ADCP.   
Set the Heading Correction to your input.   

The Velocity Scaling should be disabled. 
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4.2.6 Averaging Tab 
The Averaging property page allows you to set the Ensemble Averaging inter-
val and Reference Layer Averaging properties. 

 
Figure 11. Averaging Tab 
Enter the Temporal Averaging short-term averaging in the First Time Inter-
val box.  Use the short-term average to get more frequent updates for a data 
quality check.  The First Time Interval is what we refer to as the Short Term 
Average (which will become file name with a *.STA extension).   
Enter the long-term averaging period in the Second Time Interval box.  Use 
the long-term average to get your intended results.  The Second Time Interval 
is what we refer to as the Long Term Average (which will become file name 
with a *.LTA extension).   

Enable the Reference Layer Averaging checkbox to turn on or off the refer-
ence layer averaging feature. Using a Reference Layer helps removes biases 
caused from accelerations on platforms or ships.  To set up a Reference Layer, 
you must set the Start Bin and the End Bin to be used as the “meaning” refer-
ence layer. 
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Noise, introduced by platform accelerations, can overwhelm the velocity meas-
urements.  We have found keeping track of velocities relative to a stable refer-
ence layer can improve the data in such Cases.  As an example, suppose we 
have a four-ping ensemble.  Because signal amplitude falls off with distance, 
the deeper bins will have more of the data flagged as bad.  Bad data are not in-
cluded in averages.  As a result, the average profile might be erratic when the 
percent good is low.  In the data below, a constant profile is assumed for bins 
20 to 22, yet the average of good data shows it to be sheared. 

 Ping #  
 1 2 3 4  

Bin Velocities AVG #1 
1 5 6 18 19 12 
2 3 4 16 17 10 
↓ ↓ ↓ ↓ ↓ ↓ 
20 bad bad bad 16 16 
21 2 bad bad bad 2 
22 bad bad 15 bad 15 

 

Bins 1 and 2 have all good data; and in this example, are used as the reference 
layer.  Averaging these bins for each ping gives a reference velocity of: 
       Ping #:             1   2    3    4 
Layer Average:             4   5   17   18 
Mean Layer Average = 11 : (4 + 5 + 17 + 18) / 4 
 

When the layer average is subtracted from the velocities within each ping the 
data become: 

Bin Velocities Average #1 Average #2 
1 1 1 1 1 1 12 
2 -1 -1 -1 -1 -1 10 
↓ ↓ ↓ ↓ ↓ ↓ ↓ 
20 bad bad bad -2 -2 9 
21 -2 bad bad bad -2 9 
22 bad bad -2 bad -2 9 

 

The last column, Average #2, gives a better picture of the velocities at the 
deeper bins than the algorithm for obtaining Average #1.   

 

NOTE.  When using a reference layer, use bins in the upper part of the 
profile and bins that have a high percent good (more than 85%).  If you 
select a bad bin range, the averages will be wrong and data will be bad. 

 

 

Suggested Setting.   
You will be collecting three different files and will be able to view all three 
during real time data collection.  The first file is the raw data input, which is 
single ping data.  The selections for the other two files are based on your 
time input values here.  The First Time Interval is what we refer to as the 
Short Term Average (which will become file name with a *.STA extension).  
The Second Time Interval is what we refer to as the Long Term Average 
(which will become file name with a *.LTA extension).  You can set these to 
any times you like and they may even be the same value.   



 VmDas User's Guide 

P/N 95A-6015-00 (March 2001) page 35 

4.2.7 Data Screening Tab 
Click the checkboxes for the data screening options you wish to enable.  When 
a box is checked, its associated edit box becomes enabled, and you may enter a 
threshold value for screening the data. 

 
Figure 12. Data Screening Tab 
For RSSI (amplitude), Correlation, and Percent Good screening, the thresh-
old value represents a minimum allowed value.  For example, if you set the 
RSSI threshold to 35 counts, then any beam with an RSSI value below 35 
counts will be discarded and not used in the processed data.  RSSI and correla-
tion screening for each beam are performed on the raw data.  Percent good 
screening is performed on the averaged data. 

For Error Velocity and Vertical Velocity screening, the threshold value repre-
sents a maximum allowed value.  For example, if you set the Error Velocity 
threshold to 1500 mm/s, then any transformed ensemble that has an error 
velocity greater than 1500 mm/s will be discarded and not used in the 
processed data.  Error Velocity and Vertical Velocity screening are performed 
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data.  Error Velocity and Vertical Velocity screening are performed on the 
transformed data, before averaging. 

For Fish screening (also known as false-target detection), the threshold used 
for bottom track has a different meaning than that used for the water track ping 
or the profile ping.  In screening water data, the amplitudes of all the beams are 
compared, and if the amplitude of the weakest beam differs from the amplitude 
of the strongest beam by more than the specified number of counts (i.e. the 
threshold value), then the weaker beam is discarded.  The process is repeated 
with the remaining beams until either the test passes with three or more good 
beams, or two beams have been marked bad, in which case the profile bin is 
discarded. 

In fish screening bottom track data, the depths of all four beams are compared.  
If the depth of the shallowest beam is less than the average depth of the 
remaining beams by more than the specified percentage (i.e. the threshold 
value), then the shallowest beam is discarded.  This process is repeated until 
either the test passes with three or more good beams, or more than two beams 
have been marked bad, in which case the measurement is discarded. 

Check the box labeled Mark Data Bad Below Bottom to have the software 
mark bad all profile bins that fall below the sea bottom.  The formula is Last-
GoodBin = (ShallowestBeam) * (COS (BeamAngle)) + (BinLength).   

 

NOTE.  The ADCP has its own internal thresholds.  Setting thresholds on 
this page that is lower than those used by the ADCP will have no effect.   

While it is possible for advanced users to modify the ADCP command file 
to disable some of the internal thresholds, this practice is not 
recommended.  VmDas is designed to do those checks.  It allows you to 
change them when you reprocess the data. This gives you the maximum 
flexibility.   

 

 

Suggested Setting.   
You are able to screen data based on the items in this menu and the 
thresholds you decide during real-time or when reprocessing.  This 
screening will affect what is displayed on the screen and what data is 
recorded to the *.STA and *.LTA files.  The original raw data will be 
unaffected by what is setup here.  For real-time data collection, we 
recommend you only enable Mark Bad Below Bottom.  You can 
reprocess data later and change the settings in this screen to see what the 
effect is. 
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4.2.8 Users Exits Tab 
User exits are hooks at various points in the processing where the user can 
modify the data with an external program.  The external user application needs 
to be written so that it will keep trying to look for the appropriate file names, 
which will not exist until VmDas creates them some time after starting the pro-
gram.  It then needs to monitor the file size to determine when new data is 
available, and it has to observe the same file size limits specified for VmDas 
and automatically advance to the next file in the sequence when the size limit is 
reached. 

 
Figure 13. Users Exits Tab 
Click the Launch WinADCP checkbox to have VmDas automatically start the 
WinADCP application in monitor mode when data collection is started.  When 
in monitor mode, WinADCP will periodically refresh its displays from the data 
recorded by VmDas, and will allow you to view time series and contour graphs 
of the data.  From the WinADCP application menu, you can exit the monitor 
mode to change the WinADCP setup, and then reenter the monitor mode to con-
tinue the data updates.  The WinADCP application must be installed on the 
computer for this option to work. 
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Enter the WinADCP program file name in the WinADCP Path box, including 
the entire path for the directory in which it resides.  VmDas uses this informa-
tion to find the WinADCP application.  Alternatively, you may click the 
Browse button to navigate using the File Open dialog. 

Select which type of data to view with WinADCP using the Data File to Open 
box.  Choose from single-ping beam data, single-ping Earth data, short-term 
averaged data, or long-term averaged data.  Once data collection has started, 
you can use the WinADCP application menu to open a different file type if de-
sired.  Just remember to exit the monitor mode in order to make the change, 
then reenter monitor mode to continue the automatic data refreshing. 

Enter the number of seconds that WinADCP should wait between screen re-
freshes in the Refresh Interval (sec) box. 

 

NOTE.  When you press Stop, VmDas leaves WinADCP open so that your 
data screen does not disappear.  A consequence of that is if you have 
WinADCP enabled as a User Exit, and click Go, Stop, Go in VmDas, it will 
cause a second instance of WinADCP to run. 

 

Click the External Raw ADCP Data Screening checkbox (see “VmDas User 
Exits,” page 67 and Figure 16, page 72) to give an external user-supplied pro-
gram access to the raw ADCP data before the initial screening.  The user-
supplied program is expected to read raw ADCP ensemble data from the .ENR 
file and write the modified ensembles to an .ENJ file.  This occurs before 
VmDas performs its data screening (does not bypass it), and if additional 
screening by VmDas is desired, it may be enabled. 

Click the External Raw Nav Data Screening checkbox (see “VmDas User 
Exits,” page 67 and Figure 16, page 72) to give an external user-supplied pro-
gram access to the raw NMEA data.  Normally the VmDas NMEA data screen-
ing logic reads data from the .N1R/N2R raw NMEA data file, screens the data 
and averages the data between ADCP time stamps, then writes the averaged 
data out in binary format to a .NMS file.  When this user exit option is enabled, 
the user-supplied program is expected to read data from the .N1R/N2R files, 
and write the modified data to a .N1J or N2J text file with the same NMEA 
format.  The VmDas NMEA data screening and averaging functions will then 
read the NMEA data from the .N1J (or N2J) file instead of the .N1R (or N2R) 
file.   

 

Suggested Setting.   
If you want to view the data using WinADCP, select the Launch WinADCP 
box.  Enter the path to the WinADCP program using the Browse button.  
VmDas will automatically enter the default path. 
Select what file you want to view in the Data File to Open drop-down list. 

Select a Refresh Rate.  The WinADCP program will check VmDas for new 
data based on the Refresh Rate. 

 



 VmDas User's Guide 

P/N 95A-6015-00 (March 2001) page 39 

4.2.9 Simulated Inputs Tab 
Use the simulated data files to help learn how to use VmDas or to test the User 
Exits. 

 

NOTE.  Enabling the simulated data will automatically disable the serial 
port communications setting for the corresponding items on the 
communication setup tab. 

 
Figure 14. Simulated Inputs Tab 
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4.3 Command Files 
This page shows the direct ADCP commands that correspond to the fields set 
in the ADCP Setup Options, on the ADCP Setup tab.  You can refer to the 
ADCP Technical Manual for more information on these direct ADCP com-
mands.  See “VmDas ADCP Initialization,” page 42 for details on how the 
ADCP commands are generated and sent to the ADCP. 

To create your own command file, do the following. 

a. Open one of the default command files (see Table 2, page 8) in NotePad or 
a similar type of text editor.   

b. On the File menu, click Save AS.  Give the command file a unique name. 

c. Edit the commands as needed.  Refer to the ADCP Technical Manual for 
detailed information on each command.  You may want to add commands, 
but do not delete any command.  The commands shown in the default com-
mand file are all required.   

 

NOTE.  Use the ADCP Setup tab to set the ADCP commands.  Select 
either Use Options to set the ADCP commands on this tab or select Use 
File to use a command file (see “Load a Command File,” page 8).   

Ensemble Time must always be set on this tab.   
 

 

NOTE.  The default command files have comments that explain the 
function of each command.  It is a good idea to keep the comments and 
edit them when you make command changes.   

 

 

CAUTION.  In order for VmDas to perform correctly, your command file 
must use single ping (WP1, NP1, BP1) beam data (EX00000).  See 
“VmDas ADCP Initialization,” page 42 for details on how commands are 
sent to the ADCP. 

 

The following shows the printout of the default command file OS38BBDEF.txt.   
;--------------------------------------------------------------------------\ 
; ADCP Command File for use with VmDas software. 
;  
; ADCP type:     38 Khz Ocean Surveyor 
; Setup name:    default 
; Setup type:    High resolution, short range profile(broadband) 
;  
; NOTE:  Any line beginning with a semicolon in the first  
;        column is treated as a comment and is ignored by  
;        the VmDas software. 
; 
; NOTE:  This file is best viewed with a fixed-point font (eg. courier). 
;--------------------------------------------------------------------------/ 
 
; Restore factory default settings in the ADCP 
cr1 
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; set the data collection baud rate to 115200 bps,  
; no parity, one stop bit, 8 data bits 
; NOTE:  VmDas sends baud rate change command after all other commands in  
; this file, so that it is not made permanent by a CK command. 
cb811 
 
; Set for broadband profile mode, single-ping ensembles,  
; forty 24 meter bins, 16 meter blanking distance, 390 mm/s ambiguity vel 
NP0 
WP00001 
WS2400 
WF1600 
WN040 
WV390 
 
; Enable single-ping bottom track,  
; Set maximum bottom search depth to 2000 meters 
BP001 
BX20000 
 
; Output velocity, correlation, echo intensity, percent good 
WD111100000 
 
; Two seconds between bottom and water pings 
TP000200 
 
; Four seconds between ensembles 
; Since VmDas uses manual pinging, TE is ignored by the ADCP. 
; You must set the time between ensemble in the VmDas ADCP Setup tab 
TE00000400 
 
; Set to calculate speed-of-sound, no depth sensor,  
; External synchro heading sensor, use internal  
; transducer temperature sensor 
EZ1020001 
 
; Output beam data (rotations are done in software) 
EX00000 
 
; Set transducer depth to zero 
ED00000 
 
; save this setup to non-volatile memory in the ADCP 
CK 
 

 

NOTE.  These files have been setup for shipboard use.  They can also be used 
for stationary systems (such as Oil Rig platforms) but you must first open the 
file (right click on file and select open) and modify the EZ command from 
EZ1020001 to EZ1111111.  This new setting will enable the use of the internal 
heading, pitch, and roll sensors. 
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4.3.1 VmDas ADCP Initialization 
The following section explains how VmDas sends the commands to the ADCP. 

4.3.2 Choosing Setup Parameters 
When VmDas Collect mode starts, one part of the process is to initialize the 
ADCP.  Sending commands to the ADCP is a major part of the process.  

Some commands are generated by VmDas from setup data taken from various 
tabs of the Edit User Options dialog box.  Others are read from a command 
file. This can lead to conflicts and confusion. 

Exactly which commands must be sent depends on the type of ADCP being 
initialized.  VmDas currently recognizes the following types of ADCPs: Broad-
band (BB), Workhorse (WH), and Ocean Surveyor (OS).  If VmDas does not 
recognize the ADCP type but the data format is correct, it will display Un-
known (UN).  

 
NOTE.  For VmDas purposes, a Navigator is a BroadBand ADCP. 

 

4.3.3 Using the ADCP Setup Options 
VmDas presents an easy interface for making some setup choices in the ADCP 
Setup Options dialog.  Most of them are on the ADCP Setup tab.  The serial 
port settings are on the Communications tab.  

The ADCP Setup tab options are used only to initialize the ADCP.  They do 
not have anything to do with how VmDas processes or displays data.  They 
only control what data the ADCP collects and makes available.   

 
NOTE.  The options dialog does not completely control initialization. 

 

4.3.4 Using a ADCP File Option 
Advanced users can define a command file in the ADCP Setup tab for more 
flexibility in initializing the ADCP.  

 
NOTE.  The command file does not completely control initialization. 
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4.3.5 Interactions 
VmDas generates some required commands without input from the Edit User 
Options dialog or a command file.  

Use the ADCP Setup tab to setup the ADCP.  Select either Use Options to set 
the ADCP commands on this tab or select Use File to use a command file (see 
“Load a Command File,” page 8).  Ensemble Time must always be set on this 
tab.   

 
NOTE.  If a command is not sent to the ADCP through either the Use 
Options or Use File, the setting the ADCP had on wakeup are used. 

 

4.3.6 Automatically Generated Commands 
Some commands must be sent to the ADCP for proper functioning of VmDas. 
VmDas always generates these commands.   

Manual pinging 
VmDas generates a CF 0111x command, where x indicates that the last bit is 
unchanged from its current setting.  This bit controls the recorder.  

This setup places the ADCP in a Manual Ensemble mode.  A Manual Ensemble 
mode means that VmDas will control the timing of ADCP ensembles and there-
fore the ADCP TE command is ignored.  VmDas sets up the ADCP for single 
ping Water Profile and single ping Bottom Track (if Bottom Track is required).  
Because of this setting, the ADCP ensemble can be thought of as a ping and 
thus manual pinging. 

Beam coordinates 
VmDas generates an EX00000 command.  This places the ADCP in Beam Co-
ordinates.  With the ADCP in Beam Coordinates, VmDas is able to perform the 
transformations to Earth Coordinates.  The advantage of this is VmDas can in-
terface with external Heading, Pitch, and Roll sensors and therefore it can be 
setup to use either the internal or external input for this information. 

Magnetic corrections 
VmDas generates an EA0 and EB0 command (for an Ocean Surveyor, an EV0 
command will be generated instead of the EB0 command). 

To set the Magnetic Offset or transducer Alignment Error offsets you must use 
the Transforms tab.  
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4.3.7 Commands and How They are Generated 
The ADCP Setup Options can generate some commands, but only generates 
the command if the proper check boxes are checked.  If the boxes are checked 
then the commands created will be sent.   

If the ADCP File Option generates the commands, it is important to put them 
in the command file correctly.  Several default command files are provided 
with VmDas.  If you change or add commands refer, to your ADCP Technical 
Manual for proper command syntax.  Some of the problems that can arise are 
not obvious.  For example, since data is in beam coordinates, it is important not 
to average data in the ADCP unless the ADCP is in a fixed orientation.  This 
means that the WP command must be WP1 or in the case of the Ocean Sur-
veyor, a NP1 command may be used.  The BP command must be BP0 to dis-
able bottom tracking, or BP1 to enable it.  

If a command generates an error in the ADCP, the rest of the command file will 
not be processed.  VmDas will warn the user and continue initialization. 

The commands that can be generated by each check box in the ADCP Setup 
Options are listed below.  

Set Profile Parameters 

 
NOTE.  These commands are only generated if the Set Profile 
Parameters box is checked (see “ADCP Setup Tab,” page 27). 

 

The WN (Number of Bins), WS (Bin size), WF (Blank Distance), and ED 
(Transducer Depth) commands are generated from data in the Set Profile Pa-
rameters controls.  For an Ocean Surveyor in Narrow Bandwidth Profiling 
mode, this would be the NN, NS, NF, and ED commands instead. 

Set Processing Mode 

 
NOTE. These commands are only generated if the Set Processing Mode 
box is checked (see “ADCP Setup Tab,” page 27). 

 

If Hi-resolution (short range) option is selected, 

• For Workhorse ADCPs, WP1, WM1, WB0, and WV480 are gener-
ated.  

• For BroadBand ADCPs, WP1, WM1, WB0, and WV650 are gener-
ated.  

• For Ocean Surveyor ADCPs, NP0 and WP1 are generated.  This sets 
the Ocean Surveyor to Broad Bandwidth Profiling mode.  

• For all others, no commands are generated 
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If Low-resolution (long range) option is selected, 

• For Workhorse and BroadBand ADCPs, WP1, WM1, WB1, and 
WV330 are generated.  

• For Ocean Surveyor ADCPs, NP1 and WP0 are generated.  This sets 
the Ocean Surveyor to narrow Bandwidth Profiling mode.  

• For all others, no commands are generated 

Set BT On/Off 

 
NOTE.  These commands are only generated if the Set BT On/Off box is 
checked (see “ADCP Setup Tab,” page 27). 

 

If Off is selected, a BP0 command is generated.  If On is selected, a BP1 
command is generated and a BX command is generated from data in the con-
trol box.  

Some Workhorse ADCPs do not support bottom tracking.  The BP command 
will fail on those Workhorses.  This is OK if the ADCP Setup Options gener-
ates the BP command, but a failed command in the command file aborts proc-
essing of the command file.  The BP command should be removed from the 
command file in this case.  

Heading/Tilt Sensor 

 
NOTE.  These commands are only generated if the Set Sensor Type box 
is checked (see “ADCP Setup Tab,” page 27). 

 

If either check box is checked, an EZ command is generated.  The current EZ 
setting is read and used to generate the new command.  Only the heading and 
tilt source are changed.  

4.3.8 Serial Port Setup 
The port settings on the Communications tab control only the PC serial port, 
not the ADCP serial port.  The PC serial port parameters must be set to match 
the settings the ADCP will use when it wakes up. 

It is possible to change the ADCP serial port settings in a command file with a 
CB command.  VmDas will detect this command and hold it until all other 
command file commands are executed.  Then VmDas sends the CB command 
and makes the same change in the PC serial port.  

This is done because the command file might include a CK command to store 
the ADCP current settings in non-volatile memory.  This makes sure that the 
CB command is done after the CK command. The next time the ADCP wakes 
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up, it will have the same serial port settings as before, and the current VmDas 
serial port options will still work.  

 
NOTE.  Typically the ADCP internal serial port settings is set to 9600 
Baud, no parity, 8 data bits, and 1 stop bit. 

 

4.3.9 Detailed ADCP Initialization Procedure 
a. Open the serial port using the settings from the Communications tab. 

b. Send a break. 

c. Interpret the ADCP’s response to the break to determine what kind of 
ADCP is present.  

d. For OS, Initialize the ADCP time to the PC time with a TS command. 

e. If a command file is selected, copy it to the ADCP one line at a time with 
the following caveats. 

• Letters are converted to upper case. 

• Comments (lines starting with ;) are removed. 

• CS (Start Pinging) and CZ (Power Down) commands are not sent. 

• Baud rate commands (CB) are held until all other commands in the 
file have been sent  

• After each line, a check is done for an error message from the 
ADCP.  If one is found, no further commands from the file are sent. 
Initialization will start over. 

• Immediately after sending a CB command, change the PC serial port 
parameters to match the new ADCP parameters. 

f. For BB and WH, read the beam-to-instrument transformation matrix. Write 
it to a log on the hard disk.  

g. Send commands from the ADCP Setup tab and a few that must be sent in 
any case.  Each check box on the ADCP Setup tab enables choices to con-
figure a particular set of commands.  If the check box is unchecked, the 
ADCP Setup tab will not generate the commands, and the current ADCP 
settings will be used. 

Bottom track 

• If the Set BT On/Off check box is unchecked, nothing is sent.  

• If Off is selected, BP0 is sent. 

• If On is selected, BP1 and a BX command created from the ADCP 
Setup tab maximum range is sent. 
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Processing Mode 

• If the Set Processing Mode check box is unchecked, nothing is sent.  

• Different commands are sent to different types of ADCP, as shown 
in the tables below.  

• If Hi-resolution (short range) option is selected, the following com-
mands are sent. 

Command Command Description ADCP Type 

NP0 NB mode Pings per Ensemble OS 

WP1 Pings per Ensemble OS,BB,WH 

WM1 WT Profiling Mode BB,WH 

WB0 Mode 1 WT Bandwidth BB,WH 

WV650 WT Mode 1 Ambiguity Velocity BB 

WV480 WT Mode 1 Ambiguity Velocity WH 

<none>  All others 
 

• If Low-resolution (long range) option is selected, the following 
commands are sent. 

Command Command Description ADCP type 

WP0 Pings per Ensemble OS 

NP1 NB mode Pings per Ensemble OS 

WP1 Pings per Ensemble BB,WH 

WM1 WT Profiling Mode BB,WH 

WB1 Mode 1 WT Bandwidth BB,WH 

WV330 WT Mode 1 Ambiguity Velocity BB, WH 

<none>  All others 
 

Profile Parameters 

• If the Set Profile Parameters check box is unchecked, nothing is 
sent.  

• For Ocean Surveyor only, no commands are sent unless it is in either 
NP1 or WP1 mode.  

• For Ocean Surveyor in NP1 mode, the following commands are con-
structed and sent.  
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Command ADCP setup tab data source 

NN Number of Bins 

NS Bin Size 

NF Blank Distance 

ED Transducer Depth 
 

• For Ocean Surveyor in WP1 mode or any other type of ADCP, the 
following commands are constructed and sent. 

Command ADCP setup tab data source 

WN Number of Bins 

WS Bin Size 

WF Blank Distance 

ED Transducer Depth 
 

CF command 

• This command is always sent.  

• The current CF setting is read. A new command is generated using 
the last bit (the recorder bit) of the current setting.  

• CF 0111x is sent. 
Remaining commands 

• Heading and Tilt Sensor Source 

• If either the Heading or Tilt ADCP Setup tab check box is 
checked, the current EZ command is read.  A new EZ command 
is generated and sent with the heading and tilt characters set from 
the ADCP Setup tab settings.  

• Otherwise, nothing is sent.  

• Heading alignment.  EA0 is always sent. 

• Heading bias. 

• This is always sent. 

• For all non-Ocean Surveyor type ADCPs, EB0 is sent.  

• For Ocean Surveyor ADCPs, early versions use the EB command 
others use the EV command.  EV0 is sent. If that generates an er-
ror, EB0 is sent. 

• Beam coordinates.  EX00000 is always sent. 
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4.4 Reprocessing Data with VmDas 
a. Start VmDas.  Click File, Reprocess Data. 

b. Browse and locate the *.vmo file for the data you wish to reprocess. Click 
Open (see “File Naming Conventions,” page 73). 

c. Click Options, Edit Data Options. 

d. Click the Recording tab (see “Recording Tab,” page 29). 

• Enter the Name of the data set you wish to reprocess. 

• Enter the Number of the data set you wish to reprocess. 
e. Click the Transforms tab (see “Transforms Tab,” page 31). 

• Leave the settings for the Transform Type, Sensor Configuration, 
Orientation, and Beam Angle as selected. 

• The Heading Source needs to be selected for the input you intend to 
use.  If you will use the gyro heading being fed into the ADCP real 
time then leave it selected to ADCP.  

• The Tilt Source needs to be selected for the input you intend to use.  
f. Click the Averaging tab (see “Averaging Tab,” page 33). 

• Enter a time value for the First Time Interval. This is the Short 
Term Average (which will become file name with a *.sta extension).  
Enter a time value for the Second Time Interval. This is the Long 
Term Average (which will become file name with a *.lta extension).  
You can set these to any times you like and they may even be the 
same.   

g. Click the Data Screening tab. 

• You are able to screen data based on the items in this menu and the 
thresholds you decide.  This screening will affect what is displayed 
on the screen and what data is recorded to the *.sta and *.lta files.  
The original raw data will be unaffected by what is setup here.   

h. Save the User Option file by clicking Options, Save As. 

• Enter a file name for the *.ini file that you have just created.   
i. To start data reprocessing, on the Control menu, click Go. 



VmDas User's Guide 

page 50 RD Instruments 

4.5 Playback a Data File 
a. Start VmDas.  Click File, Playback Data. 

b. Browse and locate the data file for the data you wish to view. Click Open. 

 

NOTE. VmDas will automatically search for *.enr, *.enx, *.sta, and *.lta 
files.   

In order to view files that use other naming conventions, the user can 
either type the file name directly into the File name field of the Open File 
dialog box, or click in the Files of type box to select the All files (*.*) filter 
from the drop-down list.   

 

c. On the Playback Tool Bar, click Play.   

 
Figure 15. Playing Back a Data File 
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5 VmDas and NMEA Data 
VmDas can read in, decode, and record ensembles from an ADCP and NMEA 
data from some specific (i.e. GPS and attitude sensors) external devices.  
VmDas stores this data in both raw data files (leaving all original data input in 
its original format) and in a combined, averaged data file.  VmDas uses all of 
this data to create different displays for the user. 

As well as being able to input NMEA strings to VmDas, it can produce NMEA 
output strings of speed log information.  The speed log contains VDVBW 
(ground/water speed), VDDBT (depth), VDHDT (Heading True), and VDZDA 
(UTC Time and Date). 

5.1 General NMEA Data Format 
Much of the following information was abstracted from the NMEA 0183 stan-
dard.  Discussion is limited to NMEA strings that VmDas understands.  All 
NMEA messages are ASCII strings with the general format as shown in 
Table 3. 

Table  3: NMEA Data Format 
String Description 

$ HEX 24 – start of sentence 

<Address field> Approved address fields consist of five characters defined by the NMEA 0183 
standard. The first two characters are the TALKER identifier. The next three 
characters identify the message. 

The proprietary address field consists of the proprietary character “P” followed 
by a three-character Manufacturer’s Mnemonic Code, used to identify the 
TALKER issuing a proprietary sentence, and any additional characters as 
required.  

(VmDas accepts any two valid characters as the TALKER identifier in approved 
address fields.) 

(RD Instruments uses the RDI Mnemonic Code for proprietary address fields, 
even though it is assigned to Radar Devices. VmDas also uses the unassigned 
ADC Mnemonic Code for its own data files). 

[“,”<data field>] 
. 
. 
. 
[“,”<data field>] 

Zero or more data fields, each preceded by a “,” (comma, HEX 2C) delimiter. 

The number of data fields and their content are determined by the address field. 

Data fields may be null (contain no characters). The comma delimiter is 
required even when a data field is null. 

[“*”checksum field ] Checksum 

The checksum is the 8-bit exclusive OR (no start or stop bits) of all characters in 
the sentence, including “,” delimiters, between but not including the “$” and the 
“*” delimiters. 

The hexadecimal value of the most significant and least significant 4 its of the 
result are converted to two ASCII characters (0-9, A-F) for transmission, The 
most significant character is transmitted first.  

<CR><LF> HEX 0D 0A – End of sentence 
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Data Fields 

Detailed descriptions of each message VmDas uses are provided below. These 
descriptions use format specifiers for data fields.  The meanings of some of the 
format specifiers are listed in Table 4.  

Table  4: Data Fields 
Field Description 

hhmmss.ss A mixed fixed/variable length time field. 2 fixed digits of hours, 2 fixed digits of 
minutes, 2 fixed digits of seconds, and a variable number of digits for decimal-fraction 
of seconds.  

Leading zeros are always included for hours, minutes, and seconds to maintain fixed 
length. The decimal point and associated decimal-fraction are optional if full 
resolution is not required. 

x.x A variable length integer or floating numeric field with optional leading and trailing 
zeros. The decimal point and associated decimal-fraction are optional if full resolution 
is not required.  (example: 73.10 = 73.1 = 073.1 = 73). 

A negative sign “-“ (HEX 2D) is the first character if the value is negative. The sign is 
omitted if value is positive.  

hh A fixed length HEX number. The most significant digit is on the left. 
a 
aa 
aaa 
etc. 

A fixed length alpha field. This type of field contains a fixed number of upper-case or 
lower-case alpha characters.  

In all strings recognized by VmDas, all these fields have a length of one character. 
x 
xx 
xxx 
etc. 

A fixed length numeric field. This type of field contains a fixed number of numeric 
characters (0 - 9).  

Some fields allow negative values. If needed, a negative sign “-“ (HEX 2D) is the first 
character, increasing the length of the field by one. The sign is omitted if value is 
positive. 

A A single character status field.  

A = Yes, Data Valid, or Warning Flag Clear.  

V = No, Data Invalid, or Warning Flag Set. 

Other single 
letter 

A single character field with fixed content. The letter is the content of the data field.  

When used below, the HEX value of the letter is also given. 
 

 

NOTES.  Spaces should not be used anywhere in these NMEA strings.  
Spaces may only be used in variable text fields.  No NMEA string 
recognized by VmDas uses a variable text field. 

If data is not available or unreliable, a null field is used.  A null field is a 
field with no characters in it.  When a null field is present, two delimiters 
(comma, *, or <CR>) are found side by side.  A null field does NOT contain 
the zero character (HEX 30), the ASCII NUL character (HEX 00), a space 
(HEX 20), or other character. 

VmDas ignores some fields when it decodes messages.  The fields it reads 
are explained in “NMEA Input,” page 53. 
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5.2 NMEA Input 
The messages VmDas reads are standard GGA, HDG, HDT, VTG messages, 
and a proprietary PRDID message.  

VmDas data files may contain the proprietary PADCP message.  VmDas gener-
ates this message and uses it internally.  It is expected to be of no use exter-
nally, and is not transmitted to other devices.  It is stored in the *.N1R and 
*.N2R data files.  

5.2.1 GGA – Global Positioning System Fix Data 
Time, position, and fix related data for a GPS receiver.  
$__GGA,hhmmss.ss,llll.ll,a,yyyy.yy,a,x,xx,x.x,x.x,M,x.x,M,x.x,xxxx*hh<CR><LF> 

Table  5: GGA NMEA Format 
Field Description 
1* hhmmss.ss UTC of position - 2 fixed digits of hours, 2 fixed digits of minutes, 2 fixed digits of 

seconds, and a variable number of digits for decimal-fraction of seconds. Leading 
zeros are always included for hours, minutes, and seconds to maintain fixed length. 
The decimal point and associated decimal-fraction are optional if full resolution is not 
required.  

2* llll.ll Latitude - Two fixed digits of degrees, 2 fixed digits of minutes, and a variable number 
of digits for decimal-fraction of minutes. Leading zeros are always included for 
degrees and minutes to maintain fixed length of the first 4 chars. The decimal point 
and associated decimal-fraction are optional if full resolution is not required.  

3* a Latitude hemisphere. N or S. 
4* yyyy.yy Longitude - 3 fixed digits of degrees, 2 fixed digits of minutes, and a variable number 

of digits for decimal-fraction of minutes. Leading zeros are always included for 
degrees and minutes to maintain fixed length of the first 5 chars. The decimal point 
and associated decimal-fraction are optional if full resolution is not required.  

5* a Longitude hemisphere. E or W. 
6* x GPS Quality indicator:   

0 = fix not available or invalid 
1 = GPS fix 
2 = Differential GPS fix  
3 = GPS PPS Mode, fix valid 
4 = Real Time Kinematic. System used in RTK mode with fixed integers 
5 = Float RTK. Satellite system used in RTK mode, floating integers 
6 = Estimated (dead reckoning) mode 
7 = Manual Input Mode 
8 = Simulator mode 
This shall not be a null field. 

7 xx Number of satellites in use, 00 – 12, may be different from the number in view 
8 x.x Horizontal dilution of precision 
9 x.x Antenna altitude above/below mean-sea-level (geoid) 
10 M HEX 4D. Units of antenna altitude, meters 
11 x.x Geoidal separation. The difference between the WGS-84 earth ellipsoid and mean-

sea-level (geoid), “-“ = mean-sea-level below ellipsoid. 
12 M HEX 4D. Units of geoidal separation, meters 
13 x.x Age of Differential GPS data. Time in seconds since last SC104 Type 1 or 9 update, 

null field when DGPS is not used. 
14 xxxx Differential reference station ID, 0000-1023 

* This field is used by VmDas. 
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5.2.2 HDG – Heading, Deviation, and Variation 
Heading (magnetic sensor reading), which if corrected for deviation, will pro-
duce Magnetic heading, which if offset by variation will provide True heading. 

$__HDG,x.x,x.x,a,x.x,a*hh<CR><LF> 

Table  6: HDG NMEA Format 
Field Description 

1* x.x Magnetic sensor heading, degrees 

2* x.x Magnetic deviation, degrees  

This field and the following direction field are null if deviation is unknown.  

3* a Direction of magnetic deviation. E or W.  

4* x.x Magnetic variation, degrees 

This field and the following direction field are null if variation is unknown. 

5* a Direction of magnetic variation. E or W.  

* This field is used by VmDas. 

To obtain Magnetic Heading:  

a. Add Easterly deviation (E) to Magnetic Sensor Reading.  

b. Subtract Westerly deviation (W) from Magnetic Sensor Reading. 

To obtain True Heading: 

a. Add Easterly variation (E) to Magnetic Heading. 

b. Subtract Westerly variation (W) from Magnetic Heading. 

5.2.3 HDT – Heading – True 
Actual vessel heading in degrees True produced by any device or system pro-
ducing true heading.  

$__HDT,x.x,T *hh<CR><LF> 

Table  7: HDT NMEA Format 
Field Description 

1* x.x Heading, degrees True 

2 T HEX 54 

* This field is used by VmDas. 
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5.2.4 VTG – Track Made Good and Ground Speed 
The actual track made good and speed relative to the ground.  

$__VTG,x.x,T,x.x,M,x.x,N,x.x,K,a*hh<CR><LF> 

Table  8: VTG NMEA Format 
Field Description 

1* x.x Track, degrees true 

2 T HEX 54 

3* x.x Track, degrees magnetic 

4 M HEX 4D 

5 x.x Speed, knots 

6 N HEX 4E 

7* x.x Speed, km/hr 

8 K HEX 4B 

9 a Mode indicator 
A=Autonomous mode 
D=Differential mode 
E=Estimated (dead reckoning) mode 
M=Manual input mode 
S=Simulator mode 
N=Data not valid 
This shall not be a null field. 

* This field is used by VmDas. 

5.2.5 $PRDID 
RDI defines a proprietary NMEA message that contains ship heading, pitch, 
and roll data.  

$PRDID,x.x,x.x,x.x,*hh<CR><LF> 

Table  9: PRDID NMEA Format 
Field Description 

1* x.x Vessel Pitch, degrees. + = bow up. 

2* x.x Vessel Roll, degrees. + = port up.  

3* x.x Vessel Heading, degrees True 

* This field is used by VmDas. 

5.2.6 Reading NMEA Data 
NMEA input is not required.  VmDas can just collect ensembles from an 
ADCP.  If NMEA data is to be used, options must be set in the communications 
tab to configure the serial ports to read the data (up to two serial ports are 
available).  
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Each enabled port logs all data that arrives.  The Navigation port logs to a file 
with an N1R extension.  The RPH port uses an N2R extension.  The ports are 
not interchangeable.  VmDas expects certain data at each one.  Any unexpected 
NMEA messages will be logged, but not processed further.  

If only one port is enabled, it must be the Navigation port.  When used alone, 
this port will process any GGA, HDG, HDT, VTG, and PRDID messages it re-
ceives.  

If two ports are enabled, VmDas expects GPS data (GGA, VTG) at the Naviga-
tion port, and attitude data (HDG, HDT, PRDID) at the RPH port.  

VmDas internally generates PADCP messages and adds them to both log files.  
These messages are expected to have meaning only to VmDas. 

5.3 NMEA Output 

5.3.1 $VDDBT – Depth Below Transducer 
Water depth referenced to the transducer 

$VDDBT,x.x,f,x.x,M,x.x,F*hh<CR><LF> 

Table  10: VDDBT NMEA Format 
Field Description 

1 x.x Water depth, feet 

2 f HEX 66 

3 x.x Water depth, Meters 

4 M HEX 4D 

5 x.x Water depth, Fathoms 

6 F HEX 46 
 

5.3.2 $VDHDT – Heading – True 
Actual vessel heading in degrees True. 

$VDHDT,x.x,T*hh<CR><LF> 

Table  11: VDHDT NMEA Format 
Field Description 

1 x.x Heading, degrees True. 

2 T HEX 54 
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5.3.3 $VDVBW – Dual Ground/Water Speed 
Water referenced and ground referenced speed data. 

$VDVBW,x.x,x.x,A,x.x,x.x,A*hh<CR><LF> 

Table  12: VDVBW NMEA Format 
Field Description 

1 x.x Longitudinal water speed, knots. “-“ = astern. 

2 x.x Transverse water speed, knots. “-“ = port. 

3 A Status: water speed, A = Data valid, V = Data invalid. 

4 x.x Longitudinal ground speed, knots. “-“ = astern. 

5 x.x Transverse ground speed, knots. “-“ = port. 

6 A Status: ground speed, A = Data valid, V = Data invalid. 
 

5.3.4 $VDZDA – Time and Date 
UTC, day, month, year, and local time zone.  

$VDZDA,hhmmss.ss,xx,xx,xxxx,xx,xx*hh<CR><LF> 

Table  13: VDZDA NMEA Format 
Field Description 

1 hhmmss.ss UTC 

2 xx Day, 01 – 31. 

3 xx Month, 01 – 12. 

4 xxxx Year 

5 xx Local time zone description. –13 to 13 hours.  

The number of whole hours added to local time to obtain GMT. Zone 
description is negative for East longitudes.  

6 xx Local time zone minutes description. –59 to 59 minutes. 

The number of whole minutes added to local time to obtain GMT. This permits 
a finer resolution time zone description than is possible using hours alone.  The 
sign is the same as the hour time zone description. 

VmDas produces a null field here.  
 

5.3.5 Writing NMEA Data 
VmDas writes strings formatted as described in the NMEA 0183 standard to a 
serial port, a TCP/IP port, or both.  

 

NOTE. This is not in keeping with NMEA standards. The NMEA 0183 
standard specifies that strings are to be transmitted through a serial port.  
The NMEA 2000 standard is being developed for transmitting similar data 
over a network. VmDas does not support the NMEA 2000 standard. 
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5.4 Internal NMEA Messages 
RDI defines a proprietary NMEA message for VmDas internal use only that 
contains VmDas internal timing information. 

5.4.1 $PADCP 
This message is stored in VmDas N1R and N2R extension data files as a time 
stamp.  It is not transmitted over any I/O port.  

$PADCP, ens,yyyy,xx,xx,xx,xx,ss.ss,x.x*hh<CR><LF> 

Table  14: PADCP NMEA Format 
Field Description 

1 ens Ensemble number. A variable length integer numeric field without leading zeros. 

2 yyyy Year, 4 digits, PC local time. 

3 xx Month, 01 – 12, PC local time. 

4 xx Day, 01 – 31, PC local time. 

5 xx Hours, 00 – 23, PC local time. 

6 xx Minutes, 00 – 59, PC local time. 

7 ss.ss Seconds and hundredths, 00.00 – 59.99, PC local time. 

8 x.x PC clock offset from UTC in seconds. –86399.99 to 86399.99.  

VmDas keeps track of the date/time of GGA messages by recording the date/time 
according to the PC clock when the message is read, and calculating the offset 
between the times in the PC clock and the GGA message. If the clock offset is 
added to a GGA message time, the result is a local PC time, The offset corrects for 
the difference in time zone between local PC time and GGA time (UTC) and any 
errors because the two clocks are not perfectly synchronized. 

If no GGA messages have been read, this field is null.  
 

 

NOTES. This message is used to synchronize ensemble data and NMEA 
data. 

The year, month, day, hour, minute, and second fields describe the time 
that a ping command was sent to the ADCP. 

The ens field contains the number of the ensemble generated by the ping 
command. 

 

5.5 Further Information About NMEA Strings 
Users who need full details about NMEA data strings can find more informa-
tion in the NMEA 0183 standard, available from the National Marine Electron-
ics Association at.  

P O Box 3435  

New Bern, NC  

28564-3435 

252-638-2626 (voice) 

252-638-4885 (fax) 

nmea@coastalnet.com (e-mail)  

http://www.nmea.org/ (web site) 

 

mailto:nmea@coastalnet.com
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6 VmDas Outputs 
VmDas can output Ensemble, Speed Log, and ASCII data out the serial port or 
through an Ethernet port.   

6.1 Output Ensemble Data 
Long term averaged ensemble data is output in the RDI standard binary 
ensemble (PD0) output format. 

a. On the File menu, click Collect Data. 

b. On the Options menu, click Edit Data Options.  If you have created a 
User Option File, click Load. 

c. On the Communications tab, select the Long Term Avg Data Output 
button.   

d. To output the data to a serial port, click the Enable Serial box, and config-
ure the serial port parameters, then click the Set button to apply the new 
configuration.  Verify that the new settings appear in the Current Settings 
section. 

e. To output the data to a network port, click the Enable Network box, and 
set the Local IP Port number.  VmDas will be the server, and the local ma-
chine's IP address will be used automatically.  After data collection has 
started, a remote client can request a TCP/IP connection using the specified 
port number and the IP address of the computer running VmDas to receive 
the data. 

6.2 Output Speed Log Data 
Speed log data output consists of the NMEA VBW and DBT messages, and is 
calculated from the short-term averaged data.  Use the following procedure to 
enable speed log data output. 

 
NOTE.  Speed log data is not stored to a disk file.  It is only sent to a serial 
port and/or an Ethernet port. 

 

a. On the File menu, click Collect Data. 

b. If you have created a User Option File, on the Options menu, click Load.  
Choose your file and click OK.   

c. On the Options menu, click Edit Data Options.   

d. On the Communications tab, select the Speed Log Output button.  In the 
Select Item to Set box, choose Speed Log Output. 

e. To output the data to a serial port, click the Enable Serial box, and config-
ure the serial port parameters, then click the Set button to apply the new 
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configuration.  Verify that the new settings appear in the Current Settings 
section.  Make sure the On box is checked. 

f. To output the data to a network port, first choose an IP port number.  
VmDas uses 5434 by default, which should be fine for most users.  Remote 
clients will need to know the IP port number and the IP address of the com-
puter running VmDas to receive data.   

 Click the Enable Network box, and set the Local IP Port number.  VmDas 
will use the local machine's IP address automatically.  Click the Set button 
to apply the new configuration.  Verify that the new settings appear in the 
Current Settings section.  Make sure the On box is checked. 

 After data collection has started, a remote client can request a TCP/IP con-
nection using the specified port number and the IP address of the computer 
running VmDas to receive the data. 

Tips for Advanced Users 

Advanced users can get more control over the Speed Log data by using the fol-
lowing tips. 

Speed Log data will only be output if the serial and/or Ethernet port(s) are con-
figured for that purpose.   

• If a port is configured for speed log output, speed log output will be 
produced.  If there is no data or the data is invalid, the NMEA mes-
sages will indicate that they contain invalid data. 

The data will only be received if something is listening to the port(s).  This re-
quires a cable and usually a second computer. 

• One device may listen to a serial port.  When sending speed log data 
out an Ethernet port, VmDas is a TCP/IP server and supports up to 
100 clients. 

Speed log data is calculated from ensembles in the short-term averaged data.  
There will be one VBW and one DBT message for each short-term average en-
semble. 

• To control the time between messages, on the Options menu, click 
Edit Data Options, choose the Averaging tab, and change the First 
Time Interval. 

The speed log will contain valid data only if the ADCP is configured to pro-
duce the data.  The data comes from the bottom track field in the short-term 
average data. 

• The VBW message will contain water speed data only if the ADCP 
has been configured to produce water reference layer data.  The BK 
and BL commands are useful here. 
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• The VBW message will contain bottom speed data only if the ADCP 
has been configured to produce bottom velocity data.  The BP 
command is useful here. 

• The DBT message will contain depth data only if the ADCP has 
been configured to produce bottom track range data.  This data is 
present whenever bottom track data is being produced, and the bot-
tom is in range.  The BP and BX commands are useful here. 

• The Options on the ADCP Setup tab can override the BP and BX 
commands in a command file.  To use the ADCP defaults for these 
commands or to set them from a command file, the Set BT On/Off 
box must be unchecked. 

6.3 Output ASCII Ensemble Data 
ASCII-out files contain a fixed format of text.  You can then use these files in 
other programs (spreadsheets, databases, and word processors). 

a. On the File menu, click Collect Data. 

b. On the Options menu, click Edit Data Options.  If you have created a 
User Option File, click Load. 

c. On the Communications tab, select the Ensemble Output (ASCII) button.   

d. To output the data to a serial port, click the Enable Serial box, and config-
ure the serial port parameters, then click the Set button to apply the new 
configuration.  Verify that the new settings appear in the Current Settings 
section. 

e. To output the data to a network port, click the Enable Network box, and 
set the Local IP Port number.  VmDas will be the server, and the local ma-
chine's IP address will be used automatically.  After data collection has 
started, a remote client can request a TCP/IP connection using the specified 
port number and the IP address of the computer running VmDas to receive 
the data. 

f. In the Set Ensemble Output Configuration Here section, check the box 
for each type of data within the ensemble that you want output.  In the Data 
Select box, select the desired data source.  In the Velocity Ref box, select 
the desired reference velocity to be applied to the profile data.  In the Out-
put column, select the desired depth cell range to output by setting the 
Start Bin and End Bin.  If Mean is selected as the velocity reference, then 
in the Mean column, select the desired depth cell range to use as the refer-
ence velocity by setting the Start Bin and End Bin. 



VmDas User's Guide 

page 62 RD Instruments 

6.3.1 ASCII Ensemble Output Format 
This section explains the format of the data sent from the ADCP to the ensem-
ble-out serial device after each ADCP ensemble.  Sending ensemble-out data is 
an option in the Options, Program Options, Communications Setup menu.  
You set the communications protocol and select the data to send to the ensem-
ble-out device through the Communication options.  Ensemble-out data are in 
ASCII with fixed field lengths. 

The transmission of ensemble-out data occurs after VmDas finishes recording 
ADCP data after each ADCP ensemble.  The next section shows a sample 
ensemble-out data transmission.  The first byte in the ensemble-out data stream 
is a START OF TEXT (^B) byte.  This byte is also known as STX, ASCII 
character 2, or Control-B (^B).  VmDas always sends the STX byte when data 
transmission begins.  After the STX byte, VmDas sends a 2-byte flag that 
represents the data type that will be sent next.  See “Ensemble-Out Data 
Format Description,” page 63 for an explanation of all the flags and associated 
fields used in the ensemble-out data stream. 

6.3.2 Sample Ensemble-Out Data Transmission 
^B 0     96 91 10  2  9 54 30<CR/LF> 
 1   4   4   1   4     0     0     0     0<CR/LF> 
       6   -1375     -38      33<CR/LF> 
     -23   -1453      -2      -3<CR/LF> 
      85   -1465     -44     -52<CR/LF> 
      49   -1464     -76      30<CR/LF> 
 2   4 4   1   4<CR/LF> 
     128     119     133     142<CR/LF> 
     129     103     120     110<CR/LF> 
     117     133     141     142<CR/LF> 
 
     134     141     134     127<CR/LF> 
 3   4 4   1   4<CR/LF> 
     167     155     159     168<CR/LF> 
     162     151     149     161<CR/LF> 
     154     145     137     154<CR/LF> 
     146     138     130     152<CR/LF> 
 4   4 4   1   4<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
 
 5   4 4   1   4<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 6  0  0  0  10  100  25  25  2  0  0  0  0  5000  25  0  0  0  2500  0  0  0  35  1480<CR/LF> 
 7  2  4<CR/LF> 
     -33   -1414     -62  -32768<CR/LF> 
     833     878       0     783<CR/LF> 
 8  13856000 -324937000    634   4786    425    470<CR/LF> 
 
^C^B 0     97 91 10  2  9 55 00<CR/LF> 
 1   4   4   1   4     0     0     0     0<CR/LF> 
       7   -1373     -40      29<CR/LF> 
     -19   -1456      -1      -4<CR/LF> 
      89   -1462     -46     -51<CR/LF> 
      48   -1466     -73      34<CR/LF> 
 2   4 4   1   4<CR/LF> 
     121     123     130     139<CR/LF> 
     127     100     122     114<CR/LF> 
     130     135     140     141<CR/LF> 
 
     130     140     138     129<CR/LF> 
 3   4 4   1   4<CR/LF> 
     167     156     153     166<CR/LF> 
     163     155     147     162<CR/LF> 
     156     143     138     153<CR/LF> 
     147     140     132     151<CR/LF> 
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 4   4 4   1   4<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
     100     100     100     100<CR/LF> 
 
 5   4 4   1   4<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 -32678 -32678 -32678 -32678<CR/LF> 
 6  0  0  0  10  100  25  25  2  0  0  0  0  5000  25  0  0  0  2500  0  0  0  35  1480<CR/LF> 
 7  2  4<CR/LF> 
     -31   -1420     -58    -768<CR/LF> 
     840     862     845     850<CR/LF> 
 8  13857000 -324938000    634   4787    426    471<CR/LF> 
 
^C 

6.3.3 Ensemble-Out Data Format Description 
Each ASCII ensemble-out data stream begins with a Start Of Text code <^B> 
and ends with an End Of Text code <^C>.  VmDas identifies each data type 
with an integer flag.  At least one space separates the fields within each data 
type.  Each line of data ends with a carriage return <CR> and line feed <LF> 
sequence.   

Table  15: Ensemble-Out Data Format 
Flag Field Description 

0 1 Flag 0 identifies the ensemble number just processed by the ADCP and the 
date/time that data collection for the ensemble began.  The fields identified by this 
flag contain: 

 2 The ensemble number just processed by the ADCP. 

 3 The year data collection began for this ensemble. 

 4 The month data collection began for this ensemble. 

 5 The day data collection began for this ensemble. 

 6 The hour data collection began for this ensemble. 

 7 The minute data collection began for this ensemble. 

 8 The second data collection began for this ensemble. 

1 1 Flag 1 marks the start of velocity data.  VmDas scales the water current velocity 
data in millimeters per second (mm/s).  A value of -32768 indicates bad or 
missing data.  VmDas lists water profile velocity data in columns beginning with 
the next output line.  The fields identified by this flag contain: 

 2 The number of bins selected for transmission.   

 3 The number of beams used by the ADCP to collect the data.  This value 
corresponds to the number of COLUMNS of data beginning with the next output 
line. 

 4 The first bin selected for transmission in the Communication options. 

 5 The last bin selected for transmission in the Communication options. 

 6 The east(+)/west(-) water-current velocity of the reference layer if VELOCITY REF 
is set to BOTTOM or MEAN (Communication options). 

 7 The north(+)/south(-) water-current velocity of the reference layer if VELOCITY 
REF is set to BOTTOM or MEAN (Communication options). 

Continued Next Page 
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Table  15: Ensemble-Out Data Format (continued) 
Flag Field Description 

 8 The up(+)/down(-) water-current velocity of the reference layer if VELOCITY REF 
is set to BOTTOM or MEAN (Communication options). 

 9 The error velocity of the reference layer if VELOCITY REF is set to BOTTOM or 
MEAN (Communication options). 

 10 Column data for the east(+)/west(-) water-current velocities for the bin range 
selected in the Communication options. 

 11 Column data for the north(+)/south(-) water-current velocities for the bin range 
selected in the Communication options. 

 12 Column data for the up(+)/down(-) water-current velocities for the bin range 
selected in the Communication options. 

 13 Column data for the error velocities for the bin range selected in the 
Communication options. 

2 1 Flag 2 marks the start of correlation magnitude data.  A value of -32768 indicates 
missing data.  VmDas lists correlation data in columns beginning with the next 
output line.  The fields identified by this flag contain: 

 2 The number of bins selected for transmission.   

 3 The number of beams used by the ADCP to collect the data.  This value 
corresponds to the number of COLUMNS of data beginning with the next output 
line. 

 4 The first bin selected for transmission in the Communication options. 

 5 The last bin selected for transmission in the Communication options. 

 6 Column data for the Beam #1 correlation data for the bin range selected in the 
Communication options. 

 7 Column data for the Beam #2 correlation data for the bin range selected in the 
Communication options. 

 8 Column data for the Beam #3 correlation data for the bin range selected in the 
Communication options. 

 9 Column data for the Beam #4 correlation data for the bin range selected in the 
Communication options. 

3 1 Flag 3 marks the start of echo intensity data.  VmDas scales echo intensity data 
in ADCP counts.  A value of -32768 indicates missing data.  VmDas lists echo 
intensity data in columns beginning with the next output line.  The fields identified 
by this flag contain: 

 2 The number of bins selected for transmission.   

 3 The number of beams used by the ADCP to collect the data.  This value 
corresponds to the number of COLUMNS of data beginning with the next output 
line. 

 4 The first bin selected for transmission in the Communication options. 

 5 The last bin selected for transmission in the Communication options. 

 6 Column data for the Beam #1 echo intensity data for the bin range selected in the 
Communication options. 

 7 Column data for the Beam #2 echo intensity data for the bin range selected in the 
Communication options. 

 8 Column data for the Beam #3 echo intensity data for the bin range selected in the 
Communication options. 

 9 Column data for the Beam #4 echo intensity data for the bin range selected in the 
Communication options. 
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Table  15: Ensemble-Out Data Format (continued) 
Flag Field Description 

4 1 Flag 4 marks the start of percent-good data.  VmDas scales percent-good data in 
percentage points (0-99).  A value of -32768 indicates bad or missing data.  
VmDas lists percent-good data in columns beginning with the next output line.  
The fields identified by this flag contain: 

 2 The number of bins selected for transmission.   

 3 The number of beams used by the ADCP to collect the data.  This value 
corresponds to the number of COLUMNS of data beginning with the next output 
line. 

 4 The first bin selected for transmission in the Communication options. 

 5 The last bin selected for transmission in the Communication options. 

 6 Column data for the Beam #1 percent-good data for the bin range selected in the 
Communication options. 

 7 Column data for the Beam #2 percent-good data for the bin range selected in the 
Communication options. 

 8 Column data for the Beam #3 percent-good data for the bin range selected in the 
Communication options. 

 9 Column data for the Beam #4 percent-good data for the bin range selected in the 
Communication options. 

5 1 Flag 5 marks the start of status data.  See VmDas STA and LTA Output Data 
Format for information on how status data are scaled.  A value of -32768 
indicates bad or missing data.  VmDas lists status data in columns beginning with 
the next output line.  The fields identified by this flag contain: 

 2 The number of bins selected for transmission.   

 3 The number of beams used by the ADCP to collect the data.  This value 
corresponds to the number of COLUMNS of data beginning with the next output 
line. 

 4 The first bin selected for transmission in the Communication options. 

 5 The last bin selected for transmission in the Communication options. 

 6 Column data for the Beam #1 status data for the bin range selected in the 
Communication options. 

 7 Column data for the Beam #2 status data for the bin range selected in the 
Communication options. 

 8 Column data for the Beam #3 status data for the bin range selected in the 
Communication options. 

 9 Column data for the Beam #4 status data for the bin range selected in the 
Communication options. 

6 1 Flag 6 marks the start of leader data.  The fields identified by this flag contain: 

 2 The minutes portion of the time between pings as set by the TP-command. 

 3 The seconds portion of the time between pings as set by the TP-command. 

 4 The hundredths of seconds portion of the time between pings as set by the TP-
command. 

 5 The number of pings per ensemble as set by the WP-command. 

 6 The number of depth cells (bins) as set by the WN-command. 

 7 The depth cell (bin) length in centimeters as set by the WS-command. 

 8 The blank after transmit in centimeters as set by the WF-command. 



VmDas User's Guide 

page 66 RD Instruments 

Table  15: Ensemble-Out Data Format (continued) 
Flag Field Description 

 9 The ADCP profiling mode as set by the WM-command. 

 10 The Built-In Test result code from the last ADCP ensemble. 

 11 The sensor source as set by the EZ-command. 

 12 The available sensors as read by the PS1-command. 

 13 The low correlation threshold as set by the WC-command. 

 14 The error velocity threshold in mm/s as set by the WE-command. 

 15 The percent-good minimum as set by the WG-command. 

 16 The average ADCP pitch (tilt 1, x-axis) angle in hundredths of degrees (e.g., -70 = 
-0.7°) during the ADCP data ensemble.  This value comes from the internal 
pendulums or external gyrocompass. 

 17 The average ADCP roll (tilt 2, y-axis) angle in hundredths of degrees (e.g., 430 = 
4.3°) during the ADCP data ensemble.  This value comes from the internal 
pendulums or external gyrocompass. 

 18 The average ADCP heading angle in hundredths of degrees (e.g., 7707 = 77.07°) 
during the ADCP data ensemble.  This value comes from the internal flux-gate 
compass or external gyrocompass. 

 19 The average water temperature in hundredths of degrees C (e.g., 1711 = 
17.11°C) at the transducer head during the ADCP data ensemble. 

 20 The standard deviation (accuracy) of heading data in degrees during the ADCP 
data ensemble from the compass. 

 21 The standard deviation (accuracy) of pitch (tilt 1, x-axis) data in tenths of degrees 
(e.g., 15 = 1.5°) during the ADCP data ensemble from the 
pendulum/gyrocompass. 

 22 The standard deviation (accuracy) of roll (tilt 2, y-axis) data in tenths of degrees 
(e.g., 5 = 0.5°) during the ADCP data ensemble from the pendulum/gyrocompass. 

 23 The salinity value in parts per thousand from the ADCP (ES or EZ-command). 

 24 The speed of sound value in m/s from the ADCP (EC or EZ-command). 

7 1 Flag 7 marks the start of bottom-track data.  A value of -32768 indicates bad or 
missing velocity data.  A zero indicates bad or missing beam range data.  The 
fields identified by this flag contain: 

 2 The number of lines of bottom-track data sent.  This value corresponds to the 
number of ROWS of data beginning with the next output line. 

 3 The number of beams used by the ADCP to collect the bottom-track data.  This 
value corresponds to the number of COLUMNS of data beginning with the next 
output line. 

 4 The east(+)/west(-) bottom-track velocity in mm/s. 

 5 The north(+)/south(-) bottom-track velocity in mm/s. 

 6 The up(+)/down(-) bottom-track velocity in mm/s. 

 7 The bottom-track error velocity in mm/s. 

 8 The Beam #1 range in meters to the bottom/surface, excluding ADCP depth. 

 9 The Beam #2 range in meters to the bottom/surface, excluding ADCP depth. 

 10 The Beam #3 range in meters to the bottom/surface, excluding ADCP depth. 

 11 The Beam #4 range in meters to the bottom/surface, excluding ADCP depth. 
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Table  15: Ensemble-Out Data Format (continued) 
Flag Field Description 

8 1 Flag 8 marks the start of external navigation data collected by VmDas.  A value of 
2147483647 indicates bad or missing latitude/longitude data.  A value of -32768 
indicates bad or missing data for all other fields. The fields identified by this flag 
contain: 

 2 Navigation device latitude in thousandths of seconds. 

 3 Navigation device longitude in thousandths of seconds (-324937000 = 
W90°15'37"). 

 4 Navigation device speed in mm/s. 

 5 Navigation device course in hundredths of degrees (4786 = 47.86°). 

 6 The east(+)/west(-) navigation device velocity in mm/s. 

 7 The north(+)/south(-) navigation device velocity in mm/s. 
 

7 VmDas User Exits 
The User Exit options in VmDas are hooks at various points in the processing 
where the user can modify the data with an external program.   

• The first User Exit option selects a VmDas data file to be displayed 
using WinADCP. 

• The second User Exit option allows a program to adjust RAW 
ADCP data that VmDas put in the *.ENR file.   

• The third User Exit option allows a program to adjust RAW NMEA 
data that VmDas put in the *.N1R and *.N2R file. 

• The fourth User Exit option allows a program to perform coordinate 
transformations.   

For example, a User Exit could be used to translate all or part of a non-
supported NMEA string (e.g. Ashtech’s $GPPAT position and attitude NMEA 
string) into a supported string (e.g. RD Instruments $PRDID NMEA string).  

 

 

NOTE. The last three user exits are enabled by clicking on their associated 
checkboxes in the User Exits tab.  However, VmDas does not currently 
support automatic launching of these user exits.  They must be launched 
independently before selecting Go on the Control menu in VmDas. 
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7.1 Tips and Tricks to Creating User Exit Programs 
There are many non-supported NMEA string formats for position, heading, and 
pitch/roll devices.  In order to use a non-supported NMEA string with VmDas, 
the user needs to create a User Exit program.  The User Exit program needs to 
do the following: 

• Opens the .N1R (or .N2R) file for input (the file may not exist right 
away, so it must clear the error condition and keep trying). 

• Creates the .N1J (or .N2J) file for output. 
• Read characters from the file until an end of line is found.  It has to 

handle the fact that it will often see an End-Of-File condition, be-
cause the data may not be there yet, but it must clear the error condi-
tion and keep trying.  The best way to do this might be to check the 
file status in a loop to get the current file size and detect when it 
changes. 

• Each time it has read a complete line, decode and convert the non-
supported NMEA string into a $xxHDT string (the first two letters 
could be anything, as VmDas doesn't care about the device ID). 

• Write the new $xxHDT string out to the .N1J (or .N2J) file 
• Repeat 

This program can be written in any of several ways: 

• DOS-type program written using Borland C, or Turbo Pascal, or 
other programs. 

• Windows console program 

• Visual Basic program 

• Visual C++ program 
In other words, you can use any development tool that can create a program 
that will read and write disk files on a PC running the Microsoft Windows® 
operating system.   
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7.2 Example 1 - Modifying Raw ADCP Data 
VmDas writes the ADCP raw data into a file with the naming convention 
*.ENR.  The format of this data is the ADCP raw binary data.  The data file 
*.ENR is normally read in by the VmDas screening and filtering stage of the 
software.  The output of this screening and filtering is then written into a file 
with the naming convention of *.ENS.  A customer can set an option (via the 
User Exit tab) that will instruct the VmDas program to read in a file with the 
naming convention of *.ENJ instead of the *.ENR file.   

This allows the customer to write their own program which can modify the data 
inside the *.ENR file in anyway as long as they write the data back out into a 
file with the same original data format as the *.ENR file except they rename 
the file *.ENJ.  The VmDas program will read in the *.ENJ file and screen and 
process it as it would have the *.ENR file. 

An example of why a customer may want to do this is that the customer wishes 
to screen the heading data that is read directly by the ADCP gyro interface 
board and output to the *.ENR data file.  The customer could write a program 
that would read the heading data from the *.ENR file and compare that heading 
data to the heading in the NMEA data file *.N1R (or *.N2R).  The customer 
can then decide based on an algorithm they write which heading is more accu-
rate to use.  The customer would then take the heading they chose to use and 
write this new heading value into the raw ADCP ensemble file *.ENJ, being 
sure to modify the ADCP checksum for that ensemble as required.  The VmDas 
would read in the *.ENJ file because the user had selected the User Exit Option 
for RAW ADCP Data Screening. 

7.3 Example 2 - Modifying Raw NMEA Data 
VmDas writes the NMEA raw data into a file with the naming convention 
*.N1R or *.N2R (depending on which NMEA device we are working with).  
The format of this data is ASCII and is in the same format as what is transmit-
ted by the customers NMEA device (with one exception).  That exception be-
ing we add an ADCP mark (or time tag) string $PADCP.  The *.N1R (or 
*.N2R) data file is normally then just converted to binary and stored in a file 
with the naming convention *.NMS.  A customer can set an option (via the 
User Exit menu) that will instruct the VmDas program to read in a file with the 
naming convention of *.N1J (or *.N2J) instead of the *.N1R (or *.N2R) nam-
ing convention.   

This allows the customer to write their own program which can modify the data 
inside the *.N1R (or *.N2R) in anyway as long as they write the data back out 
into a file with the same original data format as the *.N1R (and if collected 
*.N2R) file except they rename the file *.N1J (and if N2R is collected the file 
*.N2J).  When the user turns on the User Exit option External Raw Nav Data 
Screening/Pre-Averaging the VmDas program will read in the *.N1J (or 
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*.N2J) file convert it into the binary file with the naming convention of 
*.NMS. 

An example of why a customer may want to do this is that the customer wishes 
to decode pitch and roll data from a NMEA string that the VmDas does not cur-
rently decode.  The customer can write a program that would read in the data 
from the *.N1R file (or *.N2R) and create a string that is read by the VmDas 
program from the data available in the NMEA strings.   

An example of this is seen when using an Ashtech device that outputs pitch and 
roll data in the string $GPPAT and $GPASHR.  VmDas does not currently de-
code this proprietary NMEA string.  The user could write a program that would 
take the data from either of these Ashtech NMEA strings and write them into 
the RDI propriety NMEA string $PRDID.  This RDI NMEA string contains 
heading, pitch, and roll data and is decoded by the VmDas program.   The for-
mat for this string is as follows: 
$PRDID,ppp.pp,rrr.rr,hhh.hh@   or        
$PRDID,-ppp.pp,-rrr.rr,hhh.hh@           
 

Where: 

@ = carriage return 
h = heading 
p = pitch 
r = roll 

7.4 Example 3 - Transformation 
The VmDas program normally reads in the contents of the binary file *.ENS 
and performs a beam to earth coordinate transformation.  This beam to earth 
coordinate transformation is performed using the users selections for where to 
obtain attitude information such as heading, pitch, and roll (the choices being 
either the raw ADCP leader data or the raw NMEA data).  Using this attitude 
information VmDas will transform the data from beam to earth using RDI's 
standard matrix table conversion and then writes this data to the file *.ENX.    

The VmDas program does allow however the user to perform their own coordi-
nate transformation routine.  The user would select the User Exit option of Ex-
ternal Transformation.  This choice would disable the VmDas coordinate 
transformation routine and the user would have to create their own being sure 
to write the data out in correct format to a data file with the *.ENX naming 
convention.  This is important as the next routines of the VmDas program will 
be reading in the *.ENX data for averaging, displaying, and recording in the 
*.STA and *.LTA files.   

An example of why a customer may want to do this is that the customer may 
have purchased a special RDI ADCP that does not have the standard 4-beam 
Janus configuration.  Many times these systems do not come with a coordinate 
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transformation algorithm built into them.  The user is responsible for this con-
version.    

Special Notes.  Included in the Transformation routine are the following func-
tions.  If the customer chooses to perform their own Transformation they must 
ensure that these functions are also covered.  A description of how RDI per-
forms this transformation is included in the Coordinate Transformation Book-
let. 

• Selection of the attitude sensor (based on the user input during Edit 
Data Options) 

• Apply Heading Corrections 

• Apply Beam Angle Corrected Matrix table (read from the ADCP) 

• Bin Mapping 

• Three Beam Solutions 

• Mark Data Bad Below Bottom 

• Error Velocity Screening 

• Vertical Velocity Screening 

• Percent Good Calculations and Screening 

7.5 User Displays 
The VmDas program has its own display modules built in.  The VmDas pro-
gram reads in the raw ADCP files (*.ENR), short-term average files (*.STA), 
and long term average files (*.LTA) and displays this data in either a Tabular, 
Profile, or Ship Track plot.   

The files *.ENR, *.STA, and *.LTA are available to be read by other programs 
such as WinADCP during real time data collection.  This allows a user to create 
their own software package to display, or output the data in any way they 
would like.  The only restriction is that when reading in the data file they must 
leave the data file open (or in a shared condition) so that VmDas may continue 
to access the file and update it with the new ensembles. 
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Figure 16. User Exits 
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8 File Naming Conventions 
Data files produced by VmDas during data collect mode have the following 
filename format: DeployName000_000000.Ext, 

Where: 
DeployName is a user-entered name for the deployment (up to 128 characters), 

000 is the deployment number (changes with each stop/restart), 

000000 is the file sequence number, which is incremented when the specified maximum file 
size is reached, and 

Ext is the file extension, and reflects the type of data in the file 

 

Reprocessed files have a similar format: DeployName000_000_000000.Ext, 

Where: 
000 Represents the reprocessing number, and gets incremented each time the same raw 

data is reprocessed.  The other fields are the same as for the data collect mode for-
mat, and identify the raw data source that was reprocessed. 

 

The file extensions have the following meaning:  
.ENR Raw ADCP data file (see your ADCP Technical Manual for the output data format). 
.LTA ADCP (plus Navigation Data (see “Binary Navigation Data Format,” page 75)) data that has 

been averaged using the long time period specified in the Options, Edit Data Options, 
Averaging tab. 

.STA ADCP (plus Navigation Data (see “Binary Navigation Data Format,” page 75)) data that has 
been averaged using the short time period specified in the Options, Edit Data Options, 
Averaging tab. 

.ENS ADCP data after having been screened for RSSI and correlation by VmDas, or adjusted by 
the customer via a User Exit.  Also has Navigation Data (see “Binary Navigation Data For-
mat,” page 75) records merged into the ensembles from the .NMS file. 

.ENX ADCP single-ping data (plus Navigation Data (see “Binary Navigation Data Format,” page 
75) after having been bin-mapped, transformed to Earth coordinates, and screened for 
error velocity, vertical velocity, and false targets.  This data is ready for averaging. 

.N1R, 

.N2R 
Raw NMEA data files - text files; includes ADCP time stamps with the following format: 
$PADCP,eeeee,yyyymmdd,hhmmss,-nnnnn.nn<CR><LF> 
Where: 
eeeee = ADCP ensemble number 
yyyymmdd = Year, Month, Day (date of ADCP ping) 
hhmmss.ss = Hour, minute, seconds.hundredths (Time of ADCP ping) 
-nnnnn.nn = (signed) PC clock offset from UTC in seconds; includes time zone difference). 

The .N1R extension is used for single-port NMEA data collection, or for GPS position data 
(Nav) in dual-port collection mode.  The .N2R extension is used for Roll/Pitch/Heading 
(RPH) data collection when using two serial ports for NMEA data collection. 

.NMS Binary format NAV data file after having been screened and pre-averaged. 

.VMO The option settings used for collecting the data (text file). 

.VMP The option settings used for reprocessing the data (text file). 

.ENJ ADCP raw data after adjustment by a user-exit application. 

.N1J, 

.N2J 
Raw NMEA data after being adjusted by a user-exit application. 

.LOG ASCII file containing any errors found in NEA, ASCII Ensemble Output, or ADCP communi-
cations. 

 



VmDas User's Guide 

page 74 RD Instruments 

9 ADCP Output Data Format and VMDAS 
This section shows the format of the VmDas Navigation data when using an 
ADCP.  This output can only be binary.   

The ADCP binary output data buffer contains header data, leader data, velocity, 
correlation magnitude, echo intensity, percent good, and a checksum.  The 
ADCP collects all data in the output buffer during an ensemble.  The VmDas 
program writes this ADCP output into the *.ENR files.  The *.ENR file format 
is described in the ADCP Technical Manual.   

The Navigation data is inserted before the checksum (and reserved bytes) when 
VmDas saves the STA and LTA files.  Figure 17 show the sequence in which 
the VmDas program creates the STA and LTA files that make up the binary 
output buffer.  Figure 18, page 75 shows the format of the binary Navigation 
Data.  Table 16, page 78 lists the format, bytes, fields, scaling factors, and a 
detailed description of every item in the binary navigation output buffer. 

HEADER 
FIXED LEADER DATA  Always Output 

VARIABLE LEADER DATA 
VELOCITY 

CORRELATION MAGNITUDE 
ECHO INTENSITY 

WD-command  

WP-command PERCENT GOOD 

BP-command BOTTOM TRACK DATA 

See “Binary Navigation Data Format,” page 75 NAVIGATION DATA (78 BYTES) 
RESERVED Always Output CHECKSUM 

Figure 17. ENS, ENX, STA and LTA Binary Output Data Format 
 

 

NOTE.  For a full description of the STA and LTA Binary Output Data 
Format (i.e. Header, Fixed Leader Data, etc.), see the VmDas help file and 
your ADCP Technical Manual. 
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9.1 Binary Navigation Data Format 
Figure 18. Binary Navigation Data Format 

 BIT POSITIONS  

BYTE 7 6 5 4 3 2 1 0  

1 NAVIGATION ID LSB 00h 

2  MSB 20h 

3 UTC DAY  

4 UTC MONTH  

5 LSB 

6 
UTC YEAR 

MSB 

7 LSB 

8  

9  

10 

UTC TIME OF FIRST FIX 

MSB 

11 LSB 

12  

13  

14 

PC CLOCK OFFSET FROM UTC 

MSB 

15 LSB 

16  

17  

18 

FIRST LATITUDE 

MSB 

19 LSB 

20  

21  

22 

FIRST LONGITUDE 

MSB 

23 LSB 

24  

25  

26 

UTC TIME OF LAST FIX 

MSB 

27 LSB 

28 MSB 

29 LSB 

30 

LAST LATITUDE 

MSB 

Continued Next Page 
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Continued from Previous Page 

31 LSB 

32 MSB 

33 LSB 

34 

LAST LONGITUDE 

MSB 

35 LSB 

36 
AVG SPEED 

MSB 

37 LSB 

38 
AVG TRACK TRUE 

MSB 

39 LSB 

40 
AVG TRACK MAGNETIC 

MSB 

41 LSB 

42 
SPEED MADE GOOD 

MSB 

43 LSB 

44 
DIRECTION MADE GOOD 

MSB 

45  

46 
RESERVED 

 

47  

48 
FLAGS 

 

49  

50 
RESERVED 

 

51 LSB 

52  

53  

54 

ADCP ENSEMBLE NUMBER 

MSB 

55 LSB 

56 
ADCP ENSEMBLE YEAR 

MSB 

57 ADCP ENSEMBLE DAY  

58 ADCP ENSEMBLE MONTH  

59  

60  

61  

62 

ADCP ENSEMBLE TIME 

 

63 LSB 

64 
PITCH 

MSB 

Continued Next Page 
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Continued from Previous Page 

65 LSB 

66 
ROLL 

MSB 

67 LSB 

68 
HEADING 

MSB 

69 LSB 

70 
NUMBER OF SPEED AVG 

MSB 

71 LSB 

72 
NUMBER OF TRUE TRACK AVG 

MSB 

73 LSB 

74 
NUMBER OF MAG TRACK AVG 

MSB 

75 LSB 

76 
NUMBER OF HEADING AVG 

MSB 

77 LSB 

78 
NUMBER OF PITCH/ROLL AVG 

MSB 

See Table 11 for description of fields 
 

 
NOTE.  This data is output in this format only by the VmDas program in the 
STA and LTA data files. 
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9.2 Navigation Data Format – Detailed Explanation 
These fields contain the Navigation Data.  This data is only recorded in the 
STA and LTA files created by the RDI Windows software program VmDas.  
The LSB is always sent first.  The ADCP Technical Manual has descriptions of 
commands used to set these values. 

Table  16: Binary Navigation Data Format 
Hex Digit Binary 

Byte 
Field Description 

1-4 1,2 ID Code Stores the sum of velocities identification word (20 00h). 

5-6 3 UTC Day This field contains the UTC Day.   

7-8 4 UTC Month This field contains the UTC Month. 

9-12 5,6 UTC Year This field contains the UTC Year, i.e. i.e. 07CF = 1999 

13-20 7-10 UTC Time of 
first fix 

UTC time since midnight; LSB = 0.01 seconds 

21-28 11-14 PC Clock 
offset from 
UTC 

PC Time – UTC (signed); LSB = milliseconds 

29-36 15-18 First Latitude This is the first latitude position received after the previous 
ADCP ping.    

LSB = approx. 8E-8 deg (32-bit BAM) 

In the BAM (Binary Angular Measure) format, the most signifi-
cant bit of the word has a weight of 180 degrees, and you keep 
dividing by 2 as you proceed to the right.  The lease significant 
bit for a 32-bit BAM is about 8E-8 arc degrees (180/231), or just 
under 1 cm of longitudinal distance at the equator, where 1 arc 
minute = 1 Nautical mile.  If you interpret the BAM word as an 
unsigned number, the range is 0 to (360-LSB) degrees, and if 
you interpret the BAM as a signed number, the range is –180 to 
180-LSB) degrees.  The least significant bit for a 16-bit BAM is 
about 0.0055 degrees (180/215).  Some 32-bit BAM examples 
are: 

UNSIGNED 
0x40000000   90 degrees 
0x80000000  180 degrees       
0xC0000000  270 degrees       
0xFFFFFFFF  360 degrees minus one LSB degrees 

SIGNED 
0x40000000   90 degrees 
0x80000000  minus 180 degrees 
0xC0000000  minus 90 degrees 
0xFFFFFFFF  minus one LSB degrees 

37-44 19-22 First Longi-
tude 

This is the first longitude position received after the previous 
ADCP ping. 

LSB = approx. 8E-8 deg (32-bit BAM) 

45-52 23-26 UTC Time of 
last fix 

Time since midnight UTC; LSB = 1E-4 seconds 

53-60 27-30 Last Latitude This is the last latitude position received prior to the current 
ADCP ping. 

LSB = approx. 8E-8 deg (32-bit BAM) 

Continued Next Page 
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Table  16: Binary Navigation Data Format (continued) 
Hex Digit Binary 

Byte 
Field Description 

61-68 31-34 Last Longi-
tude 

This is the last longitude position received prior to the current 
ADCP ping. 

LSB = approx. 8E-8 deg (32-bit BAM) 

69-72 35,36 Avg Speed Average Navigational Speed mm/sec (signed) 

73-76 37,38 Avg Track 
True 

Average True Navigational Ship Track Direction 

LSB = approx. 0.0055 deg (16-bit BAM) 

77-80 39,40 Avg Track 
Magnetic 

Average Magnetic Navigational Ship Track Direction 

LSB = approx. 0.0055 deg (16-bit BAM) 

81-84 41,42 Speed Made 
Good (SMG) 

Speed calculated between navigation positions.  LSB = one 
mm/sec (signed) 

The Speed Made Good (SMG) and Direction Made Good (DMG) 
quantities are calculated from the navigation fixes that enter the 
system between ADCP outputs, and are calculated as follows: 
IF: 

aLat(i) = the average of the latitudes of the nav fixes in in-
terval I 
aLon(i) = the average of the longitudes of the nav fixes in 
interval I 
Ta(i) = the average of the time of validity of the nav fixes 
in interval I 
dLat = the difference in average latitude between averag-
ing intervals 
dLon = the difference in average longitude between aver-
aging intervals 
VelMGn (i) = the velocity made good in the East direction 
for interval I 
VelMGn (i) = the velocity made good in the East direction 
for interval I 
LatToDist (dLat) is a function that converts delta Latitude 
to a distance 
LonToDist (dLon) is a function that converts delta Longi-
tude to a distance 
Smg (i) = speed made good in interval i 
Dmg (i) = direction made good in interval i 
 

THEN: 
dLat = (aLat (I-1) – aLat (i)) 
dLon = (aLon (i-1) – aLon (i)) 
VelMgn (i) = LatToDist (dLat) / (Ta(i-1) – Ta(i)) 
VelMge (i) = LonToDist (dLon) / (Ta(i-1) – Ta(i)) 
Smg(i) = sqrt(VelMgn(i)2 + VelMGe(i)2) 
Dmg(i) = atan(VelMge(i) / VelMGn(i))  

85-88 43,44 Direction 
Made Good 

(DMG) 

Direction calculated between navigation positions.  LSB-= ap-
prox. 0.0055 deg (16-bit BAM) 

89-92 45,46 Reserved Reserved for RDI use. 
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Table  16: Binary Navigation Data Format (continued) 
Hex Digit Binary 

Byte 
Field Description 

93-96 47,48 Flags Describes the validity of the data.  Each bit has represents a 
separate flag and has its own meaning 1=true, 0=false.  The flag 
bits are defined as follows: 
bit 0 = Data updated  
bit 1 = PSN Valid  
bit 2 = Speed Valid  
bit 3 = Mag Track Valid  
bit 4 = True Track Valid  
bit 5 = Date/Time Valid  
bit 6 = SMG/DMG Valid  
bit 7 = Pitch/Roll Valid  
bit 8 = Heading Valid  
bit 9 = ADCP Time Valid  
bit 10 = Clock Offset Valid  
bit 11 = Reserved 
bit 12 = Reserved 
bit 13 = Reserved 
bit 14 = Reserved 
bit 15 = Reserved 

97-100 49,50 Reserved Reserved for RDI use. 

101-108 51-54 ADCP En-
semble Num-
ber 

This field contains the sequential number of the ensemble to 
which the data in the output buffer apply. 

Scaling:  LSD = 1 ensemble; Range = 1 to 4,294,967,296 en-
sembles 

109-112 55,56 ADCP En-
semble Year 

This field contains the ADCP year, i.e. 07CFH = 1999 

113-114 57 ADCP En-
semble Day 

This field contains the ADCP day. 

115-116 58 ADCP En-
semble Day 

This field contains the ADCP month. 

117-124 59-62 ADCP En-
semble Time 

Number of seconds since midnight; LSB=1E-4 seconds 

125-128 63,64 Pitch Pitch angle.  LSB- = approx. 0.0055 deg (16-bit BAM) 

Pitch is positive when bow is higher than stern. 

129-132 65,66 Roll Roll angle.  LSB- = approx. 0.0055 deg (16-bit BAM) 

Roll is positive when the port side is higher than the starboard 
side. 

133-136 67,68 Heading Heading input.  LSB- = approx. 0.0055 deg (16-bit BAM) 

137-140 69,70 Number of 
Speed Sam-
ples Averaged 

The number of speed samples averaged since the previous 
ADCP ping. 

141-144 71,72 Number of 
True Track 
Samples Avg 

The number of True Track samples averaged since the previous 
ADCP ping. 

145-148 73,74 Number of 
Magnetic 
Track Sam-
ples Avg 

The number of Magnetic Track samples averaged since the 
previous ADCP ping. 
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Table  16: Binary Navigation Data Format (continued) 
Hex Digit Binary 

Byte 
Field Description 

140-152 75,76 Number of 
Heading 
Samples Av-
eraged 

The number of Heading samples averaged since the previous 
ADCP ping. 

153-156 77,78 Number of 
Pitch/Roll 
Samples Av-
eraged 

The number of Pitch/Roll samples averaged since the previous 
ADCP ping. 
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